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 بسم الله الرحمن الرحيم 

 :REVIT STRUCTURE DIPLOMAأولا: محتويات دبلومة الـ | 

 مشاريع كاملة ومتخلفة في الانظمة الأنشائية (  4) خلال تلك الدبلومة سيتم التطبيق علي 

 المشروع الأول:  •
 

 

 

 

 

 

 

 

 

 المشروع الثاني:  •
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  المشروع الثالث: •

 

 

 

 

 

 

 

 

 

 

 

 

 

 المشروع الرابع: •
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 المحاضرة الأولي:  .1

وكيفية استخدامها في تطوير   BIMكيفية تسطيب البرنامج + مقدمة عن تكنولوجيا الـ 

+ التعرف علي واجهة البرنامج والتعرف علي كفية التعامل معها    الهندسة الأنشائية

 ومع البرنامج ككل. 

 

 المحاضرة الثانية: .2

ويتم    Levelsوالتحكم في خصائصها وبالمثل مع المناسيب  Gridsكيفية عمل المحاور

 .التطبيق بالفعل علي علي مناسيب ومحاور مشروع منفذ بالفعل

 

 المحاضرة الثالثة:  .3

 Isolatedمن لبشة وقواعد منفصلة وقواعد مركبة  Foundationsكيفية عمل الـ 

and Combined Footing    + تعلم كيفية عمل السملات والميد العدلة والمائلة +

+ كيفية عمل حوائط السند وحوائط  Arrayتعلم كيفية عمل الخوازيق واستخدام امر الـ 

 .Retaining Wall and Shear Wall and Coreالقص 

 

 المحاضرة الرابعة:  .4

  Library والتحكم في منسوبها وارتفاعها والتحكم في الـColumns رسم الأعمدة 

والتحكم في خصائصها   Beams+ رسم الكمرات  وكيفية استيراد أعمدة دائرية

 ومنسوبها وكيفية عمل كمرة فرق منسوب والكمرات مقلوبة.

 

 المحاضرة الخامسة:  .5

 Solid Slab + Flat Slab   +Paneled Beam   +Hollowكيفية عمل البلاطات  

Block  كيفية عمل الابعاد واستخدام الكتابة من خلال قائمة الـ +Annotation. 

 

 المحاضرة السادسة: .6

+ كيفية عمل   REVITالريفيت مع برنامج  AutoCADالأتوكاد كيفية ربط برنامج 

 وكذلك الأعمدة.  الاساسات بأسلوب مختلف
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 المحاضرة السابعة:  .7
الحمام + عمل الكمرات + عمل السلالم  +  عمل البلاطات وكيفية تهبيط بلاطة 

 الرامب.

 

 المحاضرة الثامنة:  .8
 . Bill of Quantity for Concrete & R.F.T  – وللتسليح حصر الكميات للخرسانات

 

 المحاضرة التاسعة:  .9
كيفية وضع الأحمال علي برنامج الريفيت وكيفية عمل تحليل انشائي علي البرنامج  

من ومن ثم كيفية عمل تسليح لكل العناصر الأنشائية   Straining Actionsواخراج الـ 

 . Extensionsوتعلم أستخدام الـ  –أساسات  –أعمدة   –كمرات  –بلاطات 

 

 المحاضرة العاشرة: .10

 . AutoCAD+ كيفية التصدير لبرنامج الـ  3Dو الـ  2Dكيفية إخراج اللوحات الـ 

 

 المحاضرة الحادية عشر: .11

+ تعلم برنامج الروبوت   EXCELبرنامج الـ و ROBOTبرنامج الروبوت لالتصدير 

وكيفية حل المنشأ كاملا واخراج نوته حسابية وتسليح لكل العناصر الانشائية +  

وفهم لغات البرمجة المستخدمة في نمذجة معلومات  DYNAMOاستخدام برنامج الـ 

 التشييد. 

 

 

 المحاضرة الثانية عشر: .12
 تسليم ومناقشة كافة مشاريع الدبلومة. 
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 ىالمحاضرة الأول

 
 

 

 



 

  © Copyrights Engr. Ayman A. El-Bestawy – All Copyrights Reserved   
       For any Inquiries Please Contact (01064662424)             

Autodesk REVIT Structure Diploma                                                                                    Engr.Ayman Ashraf Elbestawy 

 محتويات المحاضرة الأولى: •
 .كيفية تسطيب البرنامج  .1

 ."BIM "Building Information Modelingمقدمة عن تكنولوجيا الـ    .2

 التعرف علي واجهة البرنامج.  .3

 

 | أولاً: كيفية تسطيب البرنامج:

 Installنقوم بفك ضغط الملف ونقوم بالضغط علي تثبيت   .1
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2.  
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3. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. 
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5. 

 

 

 

 

 

 

 

 

 

 

 

6.  

 

 

 

 

 

 



 

  © Copyrights Engr. Ayman A. El-Bestawy – All Copyrights Reserved   
       For any Inquiries Please Contact (01064662424)             

Autodesk REVIT Structure Diploma                                                                                    Engr.Ayman Ashraf Elbestawy 

7. 
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9.  

 

 

 

 

 

 

 

 

 

 بعد تلك الخطوة سيكون تم تثبيت وتسطيب البرنامج بنجاح.
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 Autodeskشهادات شركة 

 يوجد هناك عدة أمتحانات:  أتوديسيكللحصول علي شهادة معتمدة من شركة 

1-  Certified User 

 هو عبارة عن أمتحان مكون من الأتي: 

30 Questions 

70 Minutes 

Pass (700/1000) 

 والبرامج  التي يتم الاختبار فيه هي: 

  

 

2-  Professional User 

 أمتحان مكون من الأتي: هو عبارة عن 

35 Questions 

120 Minutes 

Pass (700/1000) 

  التي يتم الاختبار فيها:والبرامج  
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 AutoCADوبرنامج الـ  Revitالفرق بين برنامج الـ 

  : AutoCAD (Computer Aided Design)أولا: برنامج الـ 

1- 2D Drawing 

2- 3D Drawing 

 

 : Revit ثانيا: برنامج الـ

1- Modeling 

2- Analytical  Model 

3- (Tender – Shop – Co – As Built) 

Drawing 

4- Quantity Take Off 

5- Coordination 
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BIM Technology 
كية التعامل تتيح لدي مستخدمها تسهيلات كبيرة جدا من ذالبيم هي عبارة عن تكنولوجيا 

كية ذواخراج اللوحات حيث انها عبارة عن لغة برمجة    حيث التصميم والتنفيذ والحصر و

تحول البرنامج من برنامج ذو استخدام واحد الي برنامج متعدد الاستخدامات ويتميز بقوة  

 الاخراج وسهولة التعامل وسرعة التنفيذ ودقة وجودة المخرج. 

 

BIM = Building Information Modeling 

يعني نمذجة معلومات وتفاصيل المشروع اي ان تلك التفاصيل والمعلومات هي التي تبني المشروع من  

A > Z 

 

BIM History 

 .الثمانيناتخلال     BIM| تم فكرة تكنولوجيا الـ 

من خلال   علي أرض الواقع  BIMاستحداث أول برنامج بتكنولوجيا الـ | تم   1987

 . Graphisoftالتابع لشركة  ArchiCADبرنامج الـ 

 والتطبيق المباشر علي تلك التكنولوجيا.   Revitأول ظهور لبرنامج الـ  |  2002

 

BIM 

(Visualization)         3D 

)Time(         4D 

)Cost(         5D 

)Facility Management –Operation (         6D 

)Sustainability(         7D 
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Benefits of BIM Technology 

(Modeling – Accuracy & Coordination – Parametric Element) 
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Structural Flow 
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Interface of Program 
 بعد تسطيب البرنامج مباشرة تظهر لك تلك القائمة

 

 تلك الشاشة نقوم بالأتي وفي حالة عدم ظهور 

From View Tab > User Interface 
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 بالنسبة لأضافة الـ           

Structural Analysis 

Default Metric 

Menu Browser > Option > 

File Location > Add Value 
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 Menu Browserالتعرف علي الـ 
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 :واجهة البرنامج الرئيسيةبعد تجهيز كل الأعدادات نبدا بالدخول علي 

 

 : Tabs:                 الـ Quick Acces Tool Barالـ 
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 Save Reminder Intervalالـ  

Menu Browser > Options > General 

 

 

 

 

 

 

 

 

Control and Selection in Revit 

 

 

 

 

 

 

 

 

 

 



 

  © Copyrights Engr. Ayman A. El-Bestawy – All Copyrights Reserved   
       For any Inquiries Please Contact (01064662424)             

Autodesk REVIT Structure Diploma                                                                                    Engr.Ayman Ashraf Elbestawy 

View Bar & Appearance 
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 الثانيةالمحاضرة 
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 Levels & Gridsخلال تلك المحاضرة سيتم شرح كلا من المناسيب والمحاور  

 والتطيبق علي الامثلة الأتية: 

Levels: 

 

Grids: 
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 Section Boxسيتم شرح مايسمي بالـ قبل البدء في شرح المحاور والمناسيب  .1

 قائمة ال ـويتم الحصول عليه من 

Properties > Extends > Section Box 

عن طريق مكعب وهمي كما هو موضح   Modelواستخداماته التحكم الكامل بالمشروع 

وأيضاً يسهل الفرق بين النظرة الانشائية والنظرة المعمارية عن طريق القص في كل دور  

فالعكس نشائي الأيقطع في منتصف الدور وينظر لأسفل اما   المعماريحيث ان المهندس 

 .ينظر لأعلي عدا في حالة واحدة الا وهي الاساسات ينظر لأسفل 
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 Zoomمن حيث الـ   Workspace of Programما يسمي بالـ كيفية التحكم في.2

 .View Barوالـ   Navigation Cubeوالـ 

 

 

 

 

 

 

 

  Properties -Type  –Family  -Category .الفرق بين الـ 3

Category: 

 خشب ....الخ ( –أستيل  – ) خرسانة  "Columnعمود فرضا ً "

Family: 

   Rectangular – Round ام عمود مستطيل   يتم استيراده من المكتبة()   عمود دائري

Type: 

 Dimensionsقطاع العمود كابعاد  

Properties "Instance Properties": 

 المنسوب الذي يقع فيه هذا العمود وارتفاعه وباقي التفاصيل الخاص به
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 : Levels.المناسيب 4

من المعروف انه قبل البدء في اي مشروع يجب وضع مايسمي بمناسيب المشروع مثل )   -

سم وفي   80"ينص الكود المصري ان لايقل عن منسوب الحفر والردم ومنسوب التاسيس  

 . ومناسيب اسقف الادوار .....الخ( متر" 1.5التنفيذ لا يقل عن 

 Elevationلرسم المناسيب يتم رسمها في الـ  -

  Plansبينما يتم رسم المحاور في الـ  -

 

 

 

 Project Unitsلنسبة لتغير وحدات المشروع تتم عن طريق مايسمي بـ با -

 

 

 

 

 

 

 

 

 

 لتغير اسم المنسوب: لنسبةبا -
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 Temprorary Dimension:التعرف علي الـ -

 

 

 

 

 

 

 

 

 : Revitكيفية رسم المناسيب في برنامج الـ 

 Structure > Datum > Levelعن طريق اختيار   -1

 Pick Lineأو بأمر   Lineودي بيكون ليها طريقتين اما بأمر 

كما نفعل في برنامج الـ    Keyboardعن طريق استخدام اختصارات الـ  -2

AutoCAD   مع العلم انه لا يوجدCommand Bar   في الريفيت حيث التعامل

 ً  . يكون أليا
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 :بالنسبة لأختصارات برنامج الريفيت

Important Shortcuts"" 

• Units “UN” 

• Level “LL” 

• Grids “GR” 

• Visibility/Graphics “VV or VG” 

• Beam “BM” 

• Wall “WA” 

• Column “CL” 

• Floor “SB” 

• Beam System “BS”  

• Brace “BR” 

• Foundation Wall “FT”  

• Dimension “DI” 

• Text “TX” 

• Thin Line “TL” 

• Align “AL” 

• Move “MV” 

• Copy “Co” 

• Offset “OF” 

• Rotate “RO” 

• Mirror “MM or DM” 

• Trim “TR” 

• Array “AR” 

• Distance “DI” 

• Mirror “MM” 

• Properties “PR” 
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يتم اظهارها  Project Browserفي الـ  Planفي حالة عدم اظهار المناسيب كـ 

 كالاتي: 

 

 

 

 

 

 

 

 

 

 

 

 : Edit Typeوالتعديل في   Levelsبعد ذلك يتم التعرف علي خصائص الـ 

 (Elbow – Bubble Size – Drag – Check Box) 
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 : Revitفي برنامج الـ  حاوركيفية رسم الم

 Structure > Datum > Gridعن طريق اختيار  -1

 Curveأو بأمر   Pick Lineأو بأمر   Lineودي بيكون ليها طريقتين اما بأمر 

كما نفعل في برنامج الـ    Keyboardعن طريق استخدام اختصارات الـ  -2

AutoCAD   مع العلم انه لا يوجدCommand Bar   في الريفيت حيث التعامل

 ً  . يكون أليا

 Elevationsوليس الـ  Plansهنا يكون في الـ  Gridsيجب مراعاة ان رسم الـ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 ؟Propagate Extendما هو الـ -

في منسوب و محتاج اوضح تلك المحاور في   Elbowيتم استخدام في حالة استخدام الـ 

 باقي المناسيب المختلفة.
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 في منسوب   Grids. كيفية إظهار واخفاء بعض الـ 

 وأخر لا ؟! 

 . يتم تحديد المحاور التي تحتاج لأخفائها .1

2. Right Click > Hide in View > Element 

 

 

 

 

 

 

 المخفية تكون عن طريق:وفي حالة اعادة او اظهار تلك المحاور  

From View Bar > Reveal Hidden Element > Select them all > Unhide Element 
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 Familyكـ   Bubble Sizeكيفية تغير شكل الـ 

- Project Browser  

- Families 

- Annotation Symbols  

- M Grid Head 

- Right Click > Edit 
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 الثالثةالمحاضرة 
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 خلال تلك المحاضرة سيتم شرح الـ 

Columns & Walls 
 يتم رسم الأعمدة في برنامج الريفيت عن طريق الأتي: 

Structure > Column 

 CLبـ  Keyboardأو عن طريق اختصارها من الـ 

 

 

 كيفية تمثيل ورسم قطاعات الأعمدة: 

في بداية الأمر لابد من تحديد كيفية رسم قطاع العمود اما مائل أو رأسي او باستخدام أدوات  

 (.  At Grids – At Columnsسريعة التنفيذ مثل )  

 

 

 

 

 

 

 

ثم بعد ذلك نحدد اذا كان قطاع العمود يتم رسمه من أي منسوب وحتي أي منسوب أخر  

 Option Bar & Instance Propertiesوذلك يتم من خلال مايسمي بـ  
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" يكون ذلك عن طريق الضغط علي تغيير اتجاههفي حالة اردت تغيير درب العمود "

 أو عن طريق ال ـ Keyboard" من الـ Spaceالمسطرة "

Option Bar > Rotate after Placement 

 

 Ctrlلتحديد أكثر من عنصر في برنامج الريفيت يكون عن طريق 

 

 فهي تعمل علي نمذجة القطاع ف اللوحة  Tag on Placementبالنسبة لـ  

 

للتحكم في اذا كان العمود سيرسم من منسوب القواعد حتي الددور الأخير او العكس يتم   

 الاتي: تحديد 

Height  لرسم العمود من تحت لفوق والكس بالنسبة للـDepth 
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عند رسم الاعمدة تعمل علي تحريك الأعمدة عند تحريك   Move with Gridsبالنسبة لـ 

المحاور ولكن في حالة واحدة فقط الا وهي اذا كان قطاع العمود مرسوم عند منتصفه تقاطع  

 المحاور. 

 

 

 :  Material of Columnبالنسبة للتحكم في مادة العمود المستخدم 

Manage > Settings > Material > Select Concrete Material 
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" فيتم عدم تفعيل زر  Say GRCفي حالة عدم استخدام العمود المستخدم كعمود انشائي "

 Enable Analytical Modelالـ 

 

 

 

 

 

 

 ":Coverبالنسبة لتغيير الخلوص لدي قطاع العمود "

Structure > Reinforcement > Rebar Cover Settings > Duplicate 

  

 

 

 Round Columns:ماسبق كان علي الأعمدة المستطيلة في حالة أردت أستخدام أعمدة دائرية 

 سيتم ذلك عن استيرادها من مكتبة الريفيت الخاص بك 

Load Family > Library > Us Metric > Structutal Column > Concrete > 

Round Column 

ويمكن التحكم فيه  Categoryنامج ومتاح في الـ  وبذلك يكون تم اضافة قطاع العمود الدائري في البر

 بالمثل كما تم في قطاع العمود المستطيل 
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 : Edit Type بالنسبة لتعديل قطاع العمود من الـ 

 

Load تعني   Load Family 

Duplicate عمل نسخة من القطاع الحالي مع عمل قطاع اخر مختلف ولكن بالحفاظ علي وتعني  

دون التعديل عليه القطاع القديم كما هو   

Rename التعديل علي القطاع القديم مع تغيير اسمه 
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 : "Slanted Columns"بالنسبة لرسم قطاعات الأعمدة المائلة  

 ونرسم عادي حيث ان رسم قطاع العمود دا بيرسم عن طريق ضغطتين Planثم بعد ذلك هنقف في الـ 

 

وتستخدم لتتقيل سماكات الخطوط كما هو   Revitفي برنامج الـ  Thin Line. هناك مايسمي بـ 

 AutoCADببرنامج الـ 
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 كي:كيفية عمل فتحة داخل قطاع عمود كما هو في الكود الأمري

 

 يتم ذلك عن طريق الأتي:  

Structure > Openning > By Face 

 

 

 . By Faceللعمود ومن ثم اختار  Sectionفي البداية هناخد قطاع  -1

 ثم احدد قطاع العمود.  -2

 . Okثم اضغط  ثم ارسم شكل الفتحة اللي محتاجها -3
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 :Column Spliterبالنسبة لقص الأعمدة عند كل دور باستخدام الـ 

 .في البداية يتم رسم قطاع العمود من منسوب الاساسات حتي الدور الاخير  -1

 .Elevationيتم تحديد اي منسوب  -2

 . Filterتحديد الأعمدة كلها بعد عمل امر  -3

 .Split By Levelتحديد  -4

 عندها وبذلك يكون تم تقسيم الأعمدة عند كل دور. تحديد المناسيب اللي هيتم القطع  -5
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 Wallsرسم الحوائط 

 هناك نوعان في رسم الحوائط: 

1. Structure > Structure > Wall 

 Shear Wall & Coresحوائط مثل الـ ودا خاص بال

 

 

 

 

2. Structure > Foundation > Wall 

 Retaining Wallsحوائط السند ودا خاص ب

 

 

 

 

 :الخصائص الموجودة في جزئية الاعمدةنفس  

لان هذا القطاع هو  Genericيجب مراعاة عند اختيار قطاع الحائط لابد وان يكون 

 الخاص بالانشائيين. 
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 Option Barمن الـ  offsetلعمل حواف دائرية في الحوائط تتم ذلك عن طريق  
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 الرابعةالمحاضرة 
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 Foundations –الأساسات 

 خلال تلك المحاضرة سيتم شرح الأساسات بشكل كلي وكامل من حيث كلا من: 

Raft – Isolated Footing – Combined Footing – Smells – Piles -Retaining walls 

 

 

 وتحركها Tabثم تسحب الـ  Ctrlمن حيث أماكنها كل اللي عليك ان تضغط    Tapsفي حالة وجود تغير في الـ  

 

 

 عن طريق:  Foundations  – يتم رسم الاساسات 

Structure Tab > Foundation Panel > Isolated, Wall, Slab 

 

ترسم في منسوب  في البداية لرسم اي عنصر انشائي لابد من رسمه في منسوبه الخاص حيث ان القواعد العادية 

 القواعد العادية وبالمثل القواعد المسلحة ترسم في منسوب القواعد المسلحة. 
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 : Raft –في البداية: رسم اللبشة 

 يتم رسم اللبشة من  

Structure tab > Reinforcement Panel > Slab 

 ملحوظة: 

تستخدم لرسم البلاطات    Floorبينما الـ   Raft –تستخدم لرسم اللبشة  Slabفي برنامج الريفيت الـ  

 Hollow Block( بينما يتم رسم الـ  Solid – Flat – Paneled Beamالخرسانية مثل ) 

& Waffled Slab from Beam System 

 

ويتم عند رسم اللبشة يجب أولا تحديد منسوب الرسم او منسوب العنصر الانشائي ومن ثم رسمه 

 باحدي الطرق: 

 

 Panel of Drawعن طريق 

 وهي ما تحدد كيفية رسم العنصر الانشائي. Boundary Lineيوجد مايسمي بـ 

Slope Arrow   .ومنها تستطيع عمل ميول في اللبشة 

Slope Direction   ومنها يتم تحديد الاتجاه الرئيسي والاتجاه الثانوي في اللبشة كي يساعدنا في

 Shop Drawingاستخدام التسليح وكذلك الـ 

 

 Edit Typeيكون عن طريق   Thickness of Raftلضبط تخانة 
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 Underlay>Graphicsأو كشكل وهمي يكون من  Half toneلإظهار اي شكل خلال اي منسوب كـ  
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 Alignلعمل محاذاه في برنامج الريفيت يكون عن طريق امر اسمه  

 هيترحلومن ثم تحديد الشكل اللي المرحل اليه حيث يتم الاول تحديد الشكل 

 

الموجود  offsetفي حالة اردت ان تعمل رفرفة للبشة من خلال قطاع عمود يكون عن طريق الـ  

 مع كتابة البعد المراد رفرفته Option Barبالفعل في الـ  

 

يكون عن طريق تحديدها الاول ومن ثم  في حالة اردت تغير اي بعد من ابعاد اللبشة او الشكل المرسوم 

ثم التغيير   Edit Sketchالضغط علي 

 بشكل عادي. 
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 Piles -الخوازيق 

 يتم رسم الخوازيق في برنامج الريفيت خلال طريقتين: 

والتعديل في Pile Cap ومن ثم استيراد هامة خازوقية  Isolatedعن طريق استخدام  .1

 أبعادها من المكتبة. 

 " الطريقة اللي هنستخدمها. "Arrayعن طريق استيراد خازوق واحد من المكتبة وعمل أمر  .2

 

Structure > Reinforcement > Isolated > Load Family 

 

 Materialومن حيث الـ Dimenions  بعد استيراد الخازوق يتم التعديل عليه من حيث الابعاد 
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وتقرير التربة من الشائع في سوق المقاولات ان قطر الخازوق بيكون علي حسب الحمل التشغيلي له 

Profile of Soil  سم 60 –سم  50علي سبيل المثال قد يكون . 

 هو قطر الخازوق.  Dحيث الـ   3Dالمسافة بين كل خازوق واخر لاتقل عن 

 

 1.5Dوفي حالة وجو جار: 
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 :كيفية رسم الخازوق

التي تستخدم في صناعة او تنفيذ هذا الخلزوق الاول سواء كان خرسانة    Materialيكون ذلك عن طريق تحديد الـ 

 . Planوالتعديل في خصائصه وابعاده ثم بعد ذلك ترسمه في الـ   Edit Typeأو استيل او خشب ومن ثم الدخول في 

 

في الاتجاهين الافقي لتكراره  Arrayبعد رسم أول خازوق نحدده ونستخدم امر 

 والرأسي. 
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 .Option Barنقوم بالتعديل فيه عن طريق الـ   Arrayبعد تحديد امر الـ 

 . Yواتجاه الـ  Xثم بعد ذلك نكرر الخوازيق في اتجاه الـ 
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 Isolated Footing –القواعد المنفصلة 

 ذلك:رسم القواعد المسلحة "المنفصلة" ثم بعد في البداية يتم تحديد منسوب 

Structure > Foundation > Isolated  

ثم بعد ذلك ندخل  Propertiesثم بعد ذلك نحدد ابعاد قطاعات القواعد المنفصلة عن طريق قائمة الـ  

 . Edit Typeقيم القواعد من خلال الـ 

 

 Atحيث ان الـ  At Columnأو   At Grids لرسم القواعد بشكل أسرع يتم ذلك عن طريق ال 

Grids  " يتم رسم القواعد في تقاطع المحاورGrids اما بالنسبة للـ "At Column   فيتم من

خلالها رسم القواعد أسفل كل قطاع عمود وبالمثل كما هو موجود في الأعمدة نستطيع تغيير ضرب أو 

 . Space –اتجاه القواعد عن طريق المسطرة 
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 Isolatedوبالنسبة للقواعد العادية يتم التعامل معها كما يتم في حالة القواعد المسلحة من 

 .  Combined Footing –القواعد المركبة وبالمثل في حالة  

 

 Smells –السملات 

 يتم التعامل مع السملات كأنها بالفعل كمرات حتي يتم رسمها من خلال: 

Structure > Structure > Beam 
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ومن ثم نرسم من خلال   Edit Typeيتم التعديل في قطاعها من خلال  Beamبعد تحديد أمر 

Draw Panel " وفي حالة اردت تحديد اذا كان الكمرة المرسومةSmell  كمرة رئيسية او "

 Option Bar .ثانوية ....الخ يتم التعديل عليها من الـ 
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 Propertiesالـ  في حالة أردت عمل سمل مائل يتم تغيير الابعاد فيه او عن طريق

في حالة رسم السملات المائلة الافقية يكون نفس رسم كافة السملات دون حدوث اي تغيير   

 Staticalولكن يفضل رسم السملات من منتصف القواعد حتي لا يحدث اي اخطاء في الـ 

System  في حالة تصديره الي برنامج من برامج التحليل الانشائي مثل الـSAP2000 – 

Etabs – Robot . 

 

 

 

 : ةملحوظ

   Cut Lenthو الـ  Lenthهناك فرق كبير بين الـ 

 . هو طول العنصر الانشائي المرسوم بالفعل  Lenthحيث ان الـ  

هو الطول الواضح والظاهر والصافي وهو المستخدم بالفعل في حصر الكميات   Cut Lenthأما الـ  

 واخراج اللوحات. 
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 ing WallRetain  –حوائط السند 

يكون ذلك عن طريق رسم حائط عادي   Stem – Heal – Toeلرسم حائط سند يتكون من 

 من خلال: 

Structure > Structure > Wall 

ثم بعد ذلك نعدل  Foundationالموجودة بالفعل في  Wallثم بعد ذلك نستخدم ايقونة الـ 

 ونضغط فقط علي قطاع الحائط المرسوم.   Stem – Heel – Toeأبعاد كلا من الـ 

 

 ملحوظة: 

 .  Categoryمن الـ  Genericعند رسم قطاع الحائط نأخذ القطاع الـ  

 

 انه يوجد نوعين من الحوائط: ومن ثم رسم الحائط مع مراعاة 

1. Wall Bearing  .حوائط حاملة 

2. Retaining Walls   حوائط ساندة تتحمل الاحمال الجانبية مثل أحمال الردم الجانبية علي

 المنشأ. 
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  © Copyrights Engr. Ayman A. El-Bestawy – All Copyrights Reserved   
       For any Inquiries Please Contact (01064662424)             

Autodesk REVIT Structure Diploma                                                                                    Engr.Ayman Ashraf Elbestawy 

 

 

 

 

 

 

 الخامسةالمحاضرة 
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Tanks –Beam  –Slabs  

 الخزانات  –الكمرات  – البلاطات 

 :Beams  –رسم الكمرات 

لابد اولا قبل رسم اي عنصر انشائي لابد من تحديد المنسوب المراد رسم العنصر فيه 

 ومن ثم الرسم خلاله.

 يتم الرسم من خلال: 

Structure > Structure > Beam 

حيث يتم تحديد كلا من   Smell –السملات يتم رسم الكمرات كما هو الحال في 

ثم بعد ذلك تحديد ابعاد والمادة   Categoryالمنسوب اولا ومن ثم الـ 

 . Option Barالمستخدمة في نمذجة تلك الكمرة ، وأيضا تحديد الـ 
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 حيث ان: Usageستجد ما يسمي بـ  Option Barمن الـ 

Automatic  .هي الحالة العامة لرسم الكمرات / السملات 

Girder .نستخدمها في رسم كمرات الكباري سواء خرسانية أو معدنية 

Horizontal Bracing  ت المعدنية. تستخدم في المنشا 

Joist  .وهي الكمرات الثانوية 

Other .وهي القطاعات الاخرى 

Purlins .وهي الكمرات في التغطيات المعدنية 

 

 . Properties > Edit Typeالـ بعد ماسبق نحدد قطاع الكمرة المراد رسمة من  

 

بالنسبة في حالة اردت رسم كمرات مائلة او كمرات في نصف الدور يتم التحكم  

 .Propertiesفيها عن طريق الـ  
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 Propertiesيتم التحكم هنا من خلال قائمة الـ 

 Geometric Positionومن ثم التحكم في كلا من الـ  

 Y Justificationالـ  وأيضاً  YZ Justificationعن طريق الـ 

 . Z Offset Valueحتي الـ 

 

 

 .  Inverted Beam –الكمرات المقلوبة وما سبق يتم استخدامه في حالة 

 

 

 

 

 . Tag on Placementلو عايز تكتب نمذجة كل كمرة عليها يتم ذلك عن طريق الـ 
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 Slab – Hollow Block"الهوردي" 

 من خلال  Hollowيتم رسم البلاطات الـ  

Structure > Structure > Beam System 

  Ribsحيث يتم تحديد اولا كل من ابعاد البلوكات المفرغة من حيث العرض والارتفاع وبالمثل مع الـ  

 Solid Part.وأيضا الـ   الاعصاب
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  أبعاد البلوكات:
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 : Hollow Blockلرسم الـ 

Structure > Structure > Beam System 

وباقي الخصائص كما تعلمنا قبل   Option Barثم التحكم بعد ذلك والتعديل من خلال الـ  

 .ذلك
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 Marginal Beamهناك فرق في حالة لو كان المنشا محاط بالفعل بكمرات سواء كانت 

او كمرات عادية وعدم وجود كمرات أصلا ويظهر ذلك من خلال وجود تغير بسيط في  

 موضح بالشكل. الاعدادت كما هو 

 

لتحديد أبعاد الشكل وعدد الاعصاب والارتفاعات يكون من 

  .Patternومن ثم  Propertiesخلال الـ 
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 .  X , Y Directionوبالمثل نعمل ذلك في الاتجاهين الـ 

 :Tag on Placementولحذف الـ  

 

 :Hollow block Two Wayشكل الـ 
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وبالمثل يتم ذلك مع البلاطات الدائرية لكن مع اختلاف بسيط وهوا تحت اتجاة الاعصاب أولا  

Beam Direction . 

 

 

 



 

  © Copyrights Engr. Ayman A. El-Bestawy – All Copyrights Reserved   
       For any Inquiries Please Contact (01064662424)             

Autodesk REVIT Structure Diploma                                                                                    Engr.Ayman Ashraf Elbestawy 

 Automatic Beam systemفي حالة وجود كمرات محاطة بالمنشا يتم استخدام الـ 

 

والضغط علي اي اتجاه  Option Barكل اللي عليك يا هندسة انك تظبط الابعاد من الـ 

 ومن ثم رسم الكمرات ويفضل هذا النظام لسهولته. 
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 . Remove Beam Systemوفي حالة الرغبة في تعديل اي من الاعصاب نحددهم ومن ثم 

 

 

 

 

 

 Floors –البلاطات 

 يتم رسم البلاطات من خلال  

Structure > Structure > Floor 

لان دي   Floor Generic from Categoryيفضل ان تختار الـ   Floorبعد اختيار 

 الخاصة بالانشائيين. 

 بعد اختيار القطاع يتم التعديل فيه من حيث الابعاد وتحديد المادة الخاصة له من الـ 

Rename or Edit Type.  
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 . Draw Panelومن ثم  Ribbonبعد تحديد القطاع يتم الرسم من الـ 

لتحديد الاتجاه الرئيسي والاتجاه الثانوي للبلاطة    Span Directionوبعد ذلك تحدد الـ 

  والذي سيتم استخدامه بعد ذلك في التسليح وحل المنشأ.

 Edit  ومن ثم اختار  Planولتغيير أي بعد في البلاطة يتم تحديدها الاول في الـ 

Boundary. 

 

 

 

 ملحوظة: 

 لتحديد أي شكل يتم ذلك باحدي الطريقتين: 

 .Ribbon > Filterافلتره من الـ تحديد المنشأ كله ثم   .1

 . External Edgesعن طريق الضغط علي الشكل من حدوده الخارجية  .2
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ومن خلالها اي أمر أو أي أداة تعني انك هتقطع أو   New Tabبعد تحديد الشكل يتم فتح 

 هتقص في البلاطة علي حسب الشكل اللي هتختاره. 
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 عمل فتحة في قطاع الكمرة 

حول قطاع الكمرة   Sectionبالمثل زي معملنا في الاعمدة ويتم ذلك عن طريق تحديد 

ومن ثم   By Face from Ribbon of Structureومن ثم اختيار   المختار أولاً 

 تحديد الكمرة وبعد ذلك رسم الشكل سواء كان مربع أو دائرة....الخ. 

  

 للمنشأ Replicateعمل 

 ومن ثم عمل Filterويتم ذلك عن طريق تحديد البلاطة والكمرات ويتم ذلك عن طريق أمر 

Copy to Clipboard > Paste > Aligned to Selected Levels 
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Opening Shaft 

ويتم استخدامها في حالة عايز اعمل منور أو فتحة في البلاطة الخرسانية علي  

 كامل المنشأ مرة واحدة. 

Structure Tab > Opening > Shaft >Draw 

 

ومن ثم تحديد الـ    Boundary Linesبعد ذلك يتم رسم الشكل من الـ 

Symbolic Lines  وبعد ذلك ضبط الخواص من الـProperties.  
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 كيفية تهبيط بلاطة الحمام 

سم بينما   10مسافة قدرها  Solid Slabفي البداية يتم تهبيط البلاطات الكمرية 

 .سم ( 6 – 4مسافة قدرها )  Flat Slabيتم تهبيط البلاطات المصمتة الـ 

 الخرسانية من حدودها الخارجية.يتم أولاً تحديد البلاطة   .1

2.  Create > Parts.  

3.  Divide Part 

4. Edit Sketch 

 ثم بعد ذلك ترسم الشكل اللي عايز تقسمه.  .5
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تظهر منها   Propertiesوتيجي من الـ   3Dبعد مقسمت البلاطة هنيجي في الـ 

Show Parts  : وتأتي من 

3D > Properties > Graphics > Parts Visibilities > Show Parts  
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 ومن ثم تهبيطه يدوياً.  Partبعد ذلك نحدد الشكل أو الـ 

 

 .Solid Slabبالمثل ذلك مع البلاطات الـ 
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 عمل الشُخشيخة

 ويتم استخدامها بكثره فوق السلالم حتي تمنع نزول المطر داخل المنشأ 

تحديد منسوب لها أولا أو عن طريق رفع منسوب الاعمدة مسافة ويتم رسمها عن 

 معينة لكي تحمل البلاطة الخرسانية. 

 ومن ثم هنرسم بلاطة عادية فوق تلك الاعمدة  
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 ثم بعد ذلك نقوم برفع البلاطة من المنتصف 

ما يسمي الـ   Shape Editingهنحدد البلاطة أولاً ثم بعد ذلك نختار من الـ 

Add Point  ثم بعد ذلكModify Sub Element. 

 

 Add Split Lineفي حالة عايز اقسم البلاطة عن طريق خط يتم ذلك عن طريق  
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 ثم بعد ذلك نقوم برفع منسوب الخط. 

لم يتم ذلك عن طريق الامر السابق بس في حالة لو عايز اعمل قلبة سلم من غير سلا

 ونحدد البلاطة بعد ذلك. Attach Topهنرسم خطين ثم بعد ذلك نستخدم 
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TANKS 

يتم رسم الخزانات في برنامج الريفيت علي انه بلاطة وعدة كمرات وأعمدة ولا يوجد أي  

 اختلاف عما سبق وسنلاحظ ذلك

  Levelsومن ثم نعدل المناسيب  Unitsفي بداية الامر هنعدل الـ 

هنحدد نصف قطره الأول     بعد ذلك هنرسم البلاطة الدائرية " بلاطة أو أرضية الخزان "

 . Gridsويتم رسمه عن طريق عمل الـ 
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 بعد رسم البلاطة والحوائط ندخل علي رسم الاعـمدة

 Gridدرجة كـ  45بالنسبة لرسم الاعمدة علي زاوية 
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 ثم بعد ذلك نرسم باقي الاعمدة وننهي المشروع

 

 

 عمل كمرات لتربيط أعمدة الخزان:
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 السادسةالمحاضرة 
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 خلال تلك المحاضرة سنتعرف علي الآتي:

 .Revitفي برنامج الـ   Dimensions & Textكيفية عمل  .1

وتحويليها علي برنامج الـ   AutoCADكيفية استيراد لوحات من برنامج الـ  .2

Revit .كنموذج كلي للمنشأ 

 

 

Dimension & Text 

وهي بالمثل كما هي   Annotate Tabفي بداية الأمر يتم استخدام ماسبق من 

  AutoCAD موجودة في برنامج الـ 

 

في وضع الابعاد في  Dimension Panelحيث في البداية سيتم استخدام 

 برنامج الريفيت 
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 ومن ثم تحديد اي اداة  Planفي البداية هنقف في الـ 

 :Alignedوأولاً: 

عشان اعمل بعد عن طريق هذا الامر يتم ذلك عن طريق لمس أو تحديد خط وخط  

حيث في الامر الاخر يتم التحديد   Linearأخر ثم الوقوف الخارج وهذا عكس أمر 

 من نقطة ويفضل تقاطع لنقطة اخري. 
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 : Option Barمن خلال الـ  Alignedبالنسبة لخصائص الـ 

 

Wall Face   بيجيب الابعاد من الوش للوش أما الـWall Centerline 

 بيجيب الأبعاد من النص للنص. 

 

 

لو عايز ترسم أكتر من شكل أو عنصر انشائي يتم ذلك عن طريق تحديد هذا  

 . Create Similarالعنصر الأنشائي ومن ثم تحديد 
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 :PICKبالنسبة للـ 

 Quick Dimبستخدمها لما أكون عايز أجيب اكتر من بعد مره واحدة مثل الـ 

من ثم و Optionومن ثم نختار الـ  Entire Wallويتم ذلك من خلال أمر 

 .Intersecting Wallنختار  
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 .  EQويمكن التعديل وجعل المسافات كلها متساوية عن طريق الـ 

 

 

 : Angularثانياً: أمر 

 ونستخدمه في حالة حساب الزاوية علي بين أشكال مائلة.

 

بجيب منه نصف قطر  Radialوبالنسبة للاشكال الدائرية يتم رسمها عن طريق 

 . Diameterالشكل ولو عايز القطر يكون من الـ 

 

 

ويستخدم لحساب طول المنحني ويتم ذلك عن طريق تحديد   Arcبالنسبة لأمر 

 المنحني ومن ثم تحديد نقطتين عليه. 
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 ".Dimensionماسبق كان كيفية استخدام أمر الابعاد "

 .Properties > Edit Typeلتعديل ماسبق يتم اللجوء الي قائمة الـ 
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حيث يتم التعديل من هنا الكتابة ونوع وشكل الخط ولونة وحجمه وكل التفاصيل 

 الموجودة في الابعاد بشكل كلي. 
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كما كان   Revitمن برنامج الـ  Dimension Styleفي حالة أردنا تغيير الـ 

كما ذكرنا قبل ذلك  Edit Typeيتم ذلك عن طريق الـ  AutoCADفي الـ 

 وللمزيد من التفاصيل والتعمق في تلك الخصائص يتم ذلك عن طريق:

Manage Tab > Settings Panel > Additional Settings > Arrow Head 

 ويتم استخدامها لتكبير أو تصغير أو التعديل في خصائص الاسهم

 

 

 في برنامج الريفيت وهي:  Read Conventionهناك ما يسمي بالـ  

احنا كمهندسين مدني لما بنبص للوحة بنبص من تحت لفوق ومن اليمين للشمال 

فعشان كدا لازم تبقي جميع اللوحات مظبوطة ع كدا ودا بقي اللي اسمه الـ  

Read Convention. 
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 وبالمثل مع باقي الأبعاد والأتجاهات الموجود في المشروع

 Alternate Unitsريق ال  ويمكن أيضا وضع اكتر من وحدة في المشروع عن ط
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 الا وهي:  Panelالجزئية الثانية في تلك الـ 

Spot Elevation, Spot Coordinates, Spot Slope 

 Elevationعشان تقدر تستخدمهم لازم تقف في الـ 

تستخدم لتحديد منسوب مستوي  Spot Elevation حيث خلال الـ 

 مرات متتالية علي الشكل. 3معين ويتم استخدمها عن طريق تحديدها 
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وتستخدم لتحديد الاحداثيات عن طريق  Spot Coordinatesبالنسبة الـ  

 الاتجاهات خلال المشروع.

 

 : Spot Slopeبالنسبة للـ 
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Detail Panel 

1. Detail Lines  3وتستخدم في عمل الخطوط ولا تظهر في الـD 

2. Region  وتستخدم في عمل تهشير كما هو الحال في برنامج الـ

AutoCAD . 

 Propertiesويمكن التعديل في شكل وخصائص التهشير عن طريق الـ 

 . Edit Typeومن ثم الـ 
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3. Component  وتستخدم في حالة لو عايز اعمل اي قطاع بشكل

 مبسط وسريع في حالة تعذر الوقت.

4. Revision Cloud  وتستخدم في حالة وجود خطأ في المشروع

 وعايز تراجع تحليله أو رسمه.

5. Insulation  .وتستخدم في عمل العزل سواء حرارة أو رطوبة 
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 Text  -الكتابة 

كل اللي عليك انك تحدد المكان اللي هتكتب فيه ولو عايز تحفظه اضغط في 

 أي مكان أخر.

من ناحية  Wordوهناك السماحية في التعديل فيه كما هو في برنامج الـ 

 التنسيق.

 

في البرنامج يتم ذلك من نفس التنسيق من  Leaderفي حالة عايز تعمل 

 خلال الأتي: 
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 < Propertiesوبالمثل يمكن التعديل في خصائصه عن طريق الـ 

Edit Type . 

 

 

 

لو عايز بقي اكتر كل قطاع أو نمذجة لأي عنصر انشائي دا بيكون خلال 

 Tagأمر 

ودا بيحدد نمذجة العنصر اللي بختاره  Tag By Categoryحيث هناك 

 فقط.

بيحدد وينمذج  العنصر الانشائي ككل ودا اللي   Tag Allبينما الـ  

 . Revitبنستخدمه عند عمل لوحة المحاور والاعمدة في برنامج الـ 
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 لوحة المحاور والأعمدة

يتم ذلك أولا عن  Revitلعمل لوحة محاور وأعمدة في برنامج الـ  .1

 .Right Click > Duplicateومن ثم   Planطريق تحديد 

 

بأي أسم مثلا لوحة المحاور  Renameثم بعد ذلك نعمل   .2

 والأعمدة.

 

 Right Clickنحدد العناصر الانشائية الموجودة بالفعل ومن ثم  .3

> Hide in View > Element. 

 

 < Right Clickبالمثل مع الكمرات بس هنحدد الكل عن طريق  .4

Select all Instance > Visible in View . 
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 Tag all Category > Structural Columnبعد ذلك هنحدد  

Tag .بيحدد كل الاعمدة مرة واحدة 
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بعد الوصول لتلك المرحلة يتم التعديل في النمذجة عن طريق التعديل في الـ  

Family .نفسها للشكل 
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 ملحوظة: •

  Dimensionبالنسبة لتأكيس الأعمدة يتم عن طريق امر الـ 

" Gridويفضل عند عمل التاكيس يكون من طرف العمود لوش الأكس "

 نفسه. 
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Import from AutoCAD 

 : Revitكما ذكرنا من قبل انه يوجد نوعين من الرسم في برنامج الـ 

 "Grids" والـ "Levelرسم المناسيب " .1

تعديل الابعاد في المشروع ويفضل ان تكون أول خطوة في المشروع علي حسب 

 .Templateالـ 

 ثم رسم باقي المنشأ من عناصر أنشائية. 

  AutoCADاستيراد لوحات معمارية أو لوحات أنشائية من برنامج الـ  .2

 ومن ثم الرسم عليها ونمذجة باقي العناصر الأنشائية. 

 

 : Structural Analysis Default Metricفي البداية الأمر هنفتح الـ 

 

 .Project Unitsومن ثم البدء في تعديل الوحدات الخاصة بالمشروع من 
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بعد تعديل الوحدات وضبط المناسيب المختلفة في كامل المشروع نبدا في الـ 

Plan   الأول الا وهوا الـPC Footing  .كلوحة انشائية 
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 الطريقتين: عشان نستورد بقي لوحة الاساسات من برنامج الاتوكاد يتم ذلك بأحدى 

وفيها يتم استيراد لوحة الاتوكاد وفي نفس الوقت تكون مرتبطة    Link Cadهي  .1

بشكل كلي مع البرنامج حيث لو فيه أي تعديل في اللوحة هينطبق ذلك في لوحة  

 الأتوكاد وهذا غير مستحب.

وهي عبارة عن استيراد لوحة انشائية أو معمارية ...إالخ   Import Cadهي الـ   .2

 خلاليه نستطيع رسم المشروع.ومن 

 

 

 قبل استيراد الملف يجب ضبط بعد الخصائص أولاً الا وهي:
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• Color  وفيها نستخدم الـBlack and White 

تعني الحفاظ علي الألوان المستورد بها الشكل من برنامج   Preserveحيث الـ 

 .Layersالاتوكاد كمان هوا الحال ف الـ 

 وهوا تغيير اللون للعكس مثل اللون الأصفر يصبح أزرق....إلخ.  Invertedالـ 

 

• Layers / Levels   اتركها كما هي للحفاظ علي دخول واستيراد كافة

 الطبقات. 

 

• Import Units ضل الحفاظ وتحويل وحدات الاستيراد كما في  وخلالها يف

 .mmيبقي نستورد بالـ   mmفي المشروع حيث لو كان بالـ 

 

 نبقيهم كما هم.  Positioning & Place atبينما الـ  •
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بيكون  Revitإلي برنامج  AutoCADبعد استيراد اللوحة من برنامج الـ 

 Revitوتاني قفل  AutoCADاللوحة مقفولة مرتين أول قفل بيكون من الـ 

 ولفك الاقفال دي عشان اعرف أشتغل علي المشروع . 

 : Select Pinned Elementأولأ: من الـ  
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 اللي فوق شويه أوامر:   Ribbonبعد مفكيت القفل الاول بيظهر لي في الـ 

• Delete Layers وتستخدم لحذف الـ :Layer. 

• Explode.وتستخدم لتفجير اللوحة : 

• Query  وتستخدم للتحكم بشكل تام في اللوحة ودي اللي بنستخدمها في :

 التعديل علي اللوحة.

 

بعد مظبط اللوحة هبدا أنقل المشروع كله في مجالات المشروع كاملاً في مجالات  

 (.  North – South – East – West) واتجاهات الرؤية 

بكون مذطر عشان اعمل الخطوة السابقة دي اني افك القفل التاني الا هوا قفل  

 ويتم ذلك عن طريق. Revitبرنامج الـ 
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بعد موصلنا للمرحلة دي في المشروع كدا بقي جاهز انك تعديل وترسم عليه 

 Visibilityوعشان تلاقي المشروع سهل وابسط كمان في التعامل بنستخدم الـ 

/ Graphics  ومن ثمImported Category  لجعل اللوحة ذات شكل

 . Half toneشفاف لتتيح السماحية الرسم وتاتي من 
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بعد الوصول لتلك المرحلة في المشروع يتم بعد ذلك تحديد منسوب معين الا وهو  

 باقي المنشأ.منسوب القواعد العادية لنمذجة القواعد العادية ومن ثم نكرر ذلك في 
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 الخطوة التانية هو رسم القواعد المسلحة

 Wireنفس الخطوة السابقة نقف ونحدد المنسوب ثم نحول مجال الرؤية للـ 

Frame  وبعد ذلك نحول شكل اللوحة للـHalf tone    ومن ثم نعرف القطاعات

 للقواعد. 

 

عند رسم القواعد المنفصلة ستجد ترحيلها عن اللوحة المستوردة من برنامج الـ  

AutoCAD   وعلاج تلك المشكلة هو أمر "AL" Align   حيث نحدد الجهة

 اللي عايز اروحلها الأول ثم بعد ذلك احدد الشكل أو العنصر المراد تحريكه.
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 ملحوظة: 

 .Pick Lineفي اللوحة بشكل أسرع يتم ذلك من استخدام الـ  Gridsلرسم الـ 

 

 ".Beams – Smellsوبالمثل نستطيع عمل ذلك مع الكمرات "
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ولو عايز الاكسات دي بعد تعديليها تكون بنفس التعديل في باقي المناسيب يتم ذلك  

 .Propagate Extendعن طريق 

 

 

 .Retaining Wallبعد تلك الخطوة نقوم برسم حائط السند 

 



 

  © Copyrights Engr. Ayman A. El-Bestawy – All Copyrights Reserved   
       For any Inquiries Please Contact (01064662424)             

Autodesk REVIT Structure Diploma                                                                                    Engr.Ayman Ashraf Elbestawy 

 

 

 

 

 

 

 

 

 

 

 Retaining Wall fromبعد ذلك نقوم بتحويله من حائط عادي لـ 

Foundation Panel. 
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 بالنسبة لرسم لسملات سواء العدلة أو المائلة: 

نفس اللي كنا بنعمله في الكمرات لا أكتر ولا اقل ويتم الرسم من منتصف قطاع  

 .Analytical Modelالعمود حتي منتصف قطاع العمود الاخر عشان الـ 
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 السابعةالمحاضرة 
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حيث خلال   6في المحاضرة دي هنكمل المشروع اللي بدأناه المحاضرة رقم 

 مرات والبلاطات والاعمدة والسلالم والرامب. المحاضرة دي هنعمل الك

 

 

 

 

 

 

 

 

 

 :في البداية هنرسم الأعمدة

 Columns –الأعمدة 

 هناك نوعان من رسم الاعمدة:

 رسم أعمدة كل دور علي حدى وأنا لا افضل ذلك عشان بتاخد وقت كتير.  .1

حتي منسوب الدورر الأخير   RC Footingرسم الأعمدة من منسوب الـ  .2

 Column Splitومن ثم لو عايزين نعمل قص للأعمدة يتم استخدام ال 

 ودي الطريقة اللي بفضلها عشان سرعه التنفيذ والوقت. 

 

 RCوان شاء الله هنشتغل بالطريقة التانية الا وهي الوقوف في منسوب الـ 

Footing  .ومن ثم رسم الأعمدة حتي منسوب الدور الاخير 
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وبالمثل يتم التعامل معاها بنفس خصائص الاعمدة من حيث تغيير ضربها  

 .Alignواستخدام أمر 
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في حالة لو كنت عايز ترسم الأعمدة ومش ظاهرة معاك في اي منسوب ممكن  

ومن ثم   Propertiesتظهرها بشكل مرشد وتخفيها بعد ذلك ويتم من خلال الـ  

Graphic > Underlay  .ومنها تظهر اي لوحة 

 

بعد مخلصنا رسم الاعمدة ندخل بقي علي استيراد لوحة الدور الارض أو سقف  

 تتم بنفس الخطوات السابقة.الدور البدروم و 

 

 

 Visibility / Graphicsلو عايز تخفي لوحة الاتوكاد المستوردة تتم من الـ 

"vv or vg". 
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بالمثل علي ماسبق هنستورد أيضا الدور المتكرر أو سقف الدور الأرضي وبعد ذلك  

 نكرر المشروع كاملاً.

 

 

 

 

 

 

 

 

 

 

 

للمناور ولفانوس   Shaftبعد مكررنا وخلصنا المنشأ ندخل نعمل فتحة في المنشأ  

 السلم.
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 .View Barبيكون من الـ  Analytical Modelلو عايز تشوف الـ  

 

 

 (. Etabs – Robotدا اللي بنستخدمه للتصدير لبرامج التحليل الأنشائي ) 
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طابق كمان علي ربع مساحة المبني فدا  في الدور الاخير كان مسموح أن انا اعمل 

بيكون عن طريق عمل منسوب أخر ونكمل كما سبق بس لازم هنا هطلع أعمدة  

أعمدة   4أعمدة و 6هتكون واخده خصائص مختلفة عشان تكمل معاك وعددهم = 

 زيادة عشان الشوخشيخة.
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 ذكرناها قبل ذلك. بالمثل هعنمل كمان الشُخشيخة فوق السلم كمان 

 وبكدا نبقي خلصنا أول جزئية ندخل بعد كدا علي السلالم والرامب. 
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 Stairs  –السلالم 
خاصة بالمهندسين الإنشائيين حيث لو انت   Structure Tabمن المعروف ان 

  عايز ترسم كمرة أو بلاطة أو عمود أو أساسات هتلاقيهم موجودين.

السلالم والرامب مش هتلاقيهم موجودين لأنهم بكل بساطة بس لو جيت تدور علي 

وبالتالي عشان ترسمهم في البرنامج يبقي لازم   من اختصاص المهندس المعماري

 .Architecture Tabتدخل علي 

 

 : Circulation Panelهتلاقي عندك من  

• Railing : .ودي خاصة بالدرابزين 

• Rampاللي بترسم في الاساسات. : ودي خاصة بالرامب أو البلاطة المائلة 

• Stair.ودي مختصة برسم السلالم ودي اللي هنرسم منها السلم :  
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 اذن يتم رسم السلم من:

Architecture > Circulation > Stair > Category > 

Monolithic 

 لأن دي أنسب حاجة لينا كمهندسين مدني.  Monolithicبنختار الـ 

 بيكون فيه سهم أسفل الكلمة بيكون فيه:  Stairلما بختار بقي الـ  

• Stair by Component  ودا اللي هنستخدمه لانه بيكون معرف :

 ومجهز قطاعات جاهزة فبيكون عملي وسريع.

• Stair by Sketch : ودا بنستخدمه لما بتكون عايز ترسم سلم من البداية

 . خالص وتظبط في القايمة والنايمة وكل دا



 

  © Copyrights Engr. Ayman A. El-Bestawy – All Copyrights Reserved   
       For any Inquiries Please Contact (01064662424)             

Autodesk REVIT Structure Diploma                                                                                    Engr.Ayman Ashraf Elbestawy 

 : Stair by Componentهنشتغل علي الـ 

  

 بيكون عندك الآتي: 

• Run.ودي اللي برسم منها قلبة السلم : 

• Landing .ودي اللي يقصد بيها البسطة أو الصدفة : 

• Support .ودي اللي يقصد بيها الركيزة أو الكمرة اللي هتشيل السلم : 

 

 

 تبقي عارفهم كويس:في البداية كدا بيكون فيه شوية مصطلحات لازم  

1.   Run = Flight قلبة السلم. 

2. Riser    ( 17 – 15دي القايمة وبتكون في حدود .)سم 

3. Tread =  Going ( 28 – 25دي النايمة وبتكون في حدود  .)سم 
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 قلبات وهوا ما يستم رسمه في المشروع. 3نموذج مصغر للسلم 
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السلم عكس عقارب الساعة وذلك حتي يتماشى مع يفضل ان يكون الصعود علي 

 اتجاة الدورة الدموية في جسم الأنسان ويكون أريح لعضلة القلب. 
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 تعالوا بقي نبدأ نفهم ايه اللي موجود في جزئية السلالم. 

 

منها شكل السلم ودي بترسم  Component Panelفي البداية بيكون عندك 

 بتاعك سواء كان دائري أو مستقيم أيا كان شكله. 

 

ودا بتحدد منه عرض القلبة وبعض  Option Barبعد كدا بيكون عندك الـ 

اللي من خلالها بقدر احدد ان   Location Linesزي الـ  الخصائص الاخري 

 السلم هيترسم علي اليمين ولا الشمال ولا من المنتصف. 

 

اللي من خلالها بقدر أعدل في قطاع   Propertiesبعد كدا بيكون عندي الـ 

 ومنسوب السلم بكل كلي وكامل. 
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 Editبقدر من خلال الـ  Propertiesخلال قائمة الـ 

Type  القطاع. التعديل في 

 :  Constraintsبالنسبة للجزء بتاع الـ 

 Topوالـ  Base Levelمن خلالها اقدر أعدل في الـ 

Level  ولو عايز أعملOffset   أي مسافة في

 المناسيب 

وفي حالة لا يوجد مناسيب في المشروع أقدر احدد  

ارتفاع السلم الكلي وهوا بيرسم خلاله من الـ  

Desires Stair Height . 

وفي حالة عايز السلم يتكرر مرة واحدة دون اللجوء  

 Multistoryيتم ذلك عن طريق الـ  Copyلعملية الـ 

Top Level . 

 

 

 : Dimensionبالنسبة لجزئية الـ  

ودي من خلالها بقدر أحدد أرتفاع القايمة وعرض النايمة وعدد درجات السلم 

 ارتفاع القايم الواحد () أرتفاع الدور الواحد ÷ بحيث ان عدد درجات السلم = 

 وفي حالة قللت في ارتفاع القايم كلما زاد عدد الدرجات. 
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 . Monolithicطبعاً كما ذكرنا قبل ذلك ان شغلنا هيكون علي الـ 

 

 

 

 

 

 

 

 

 

 

 

لو عايز تعرف وتشوف المعادلات اللي البرنامج بيرسم بيها بيكون من الـ  

Calculation Rules.  
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 سم بيكون من الـ   18سم أو 20لو عايز بقي تعدل في تخانة السلم مثلا 

Constructions > Run Type > Select 3 Point … 

في البداية بيكون عندك حاجة  

 Undersideاسمها الـ 

Surface  ودي من خلالها :

أقدر أعمل السلم المنشار اللي  

هوا بيكون مكسر أو نوايم وقوايم  

من فوق ومن تحت ودا بيكون من  

 .Steppedخلال الـ  

دي السلم  Smoothبينما الـ 

 المعتاد بتاعنا. 

 

 Structuralبالنسبة لـ 

Depth   منها التخانة. دا بيغير 

 

بعد متخلص رسم السلم وتيجي تدور عليه مش هتلاقيه خالص عشان انت شغال 

خاص بالانشائيين    Templateفي 

وأنت بترسم حاجه خاصة بالمعماري  

فعشان تظهره هتظهره من الـ  

Visibility / Graphics > 

Model Category. 
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 . Structure & Architectureومنها احدد الـ 

 وبكدا يظهر.  Check Markو أفعل علامة الـ  Stairومن ثم انزل علي السلالم 
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 لو عايز تلغي الميل في درجات السلم بيكون من: 

 هحدد السلم أولاً.  .1

2. Edit Type . 

3. Slanted .هلغي تفعيلها وخلاص  
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 3 – 2لو عايز تعمل أنف في السلم ) المسافة من الرخام أو السيراميك ذات البعد 

 سم ( بيكون من الأتي:

 .Tread & Riserعن طريق تفعيل ال 
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في حالة رسم أشكال مختلفة مثل سلم مروحة أول سلم دائري بيكون بنفس  

 السلم المستخدم فقط.الخطوات السابقة مع تعديل وتغيير نوع 
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Stair by Sketch 

 ودي بنستخدمها في حالة لو عايز انت تبدا ترسم لوحدك وتعمل أشكل براحتك. 

 بيكون عندك الآتي: 

 ×Run .ودي اللي برسم منها قلبة السلم 

 ×Boundary   .ودي اللي برسم منها حدود السلم 

 ×Riser  .ودي اللي برسم منها القوايم 

 

 

 القايمة وبتكون أول درجة في السلم. Riserبرسم أولا بـ 
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 .   Boundaryبعد ذلك نرسم الحدود الخارجية للسلم من 

 

 يتم من خلالها الرسم علي حدود السلم كله بشكل كامل عدا الرسم علي الدرجات. 
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من مميزات الرسم بتلك الطريقة اننا نقدر نعدل في خصائص السلم يعني ممكن  

 نعمل أول درجة مثلا علي شكل منحني. 
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لو عايز تعمل أي تعديل ف السلم بيكون عن طريق تحديد السلم من حدوده  

ومن ثم التعديل فيه بكل   Ribbonمن الـ  Edit Stairالخارجية ومن ثم عمل 

 سهولة.
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 .Multistory Top Levelثم بعد ذلك نكرر المنشأ من خلال 

 

 

 

 

 

 

 

 

 

 

 



 

  © Copyrights Engr. Ayman A. El-Bestawy – All Copyrights Reserved   
       For any Inquiries Please Contact (01064662424)             

Autodesk REVIT Structure Diploma                                                                                    Engr.Ayman Ashraf Elbestawy 

 .Railingلو عايز تظهر الدرابزين بيكون من الـ  
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لو عايز تدخل تعدل في الدرابزين بيكون من خلال تحديده والتعديل في مايسمي بالـ  

Baluster . 

 Balusterبدخل أحدد الـ 

Placement   ومن ثم أدخل أعدل

 .Edit Typeمنه الـ  
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 Ramp –الرامب 
الجراجات بكثر لانه بيربط بين منسوبين ويتم عمله في البدروم ويتسخدم في 

مختلفين عن طريق بلاطة مائلة من منسوب الصفر مثلا أو منسوب الشارع وإلي  

 متر "مثلا".  3.00-منسوب 

 يتم رسم الرامب من نفس طريقة رسم السلالم حيث: 

Architecture > Circulation > Ramp 

 . تفي بداية الأمر يتم تحديد المناسيب وتعديل الوحدا

 .Propertiesمن الـ  Rampهبدأ أعدل مناسيب رسم الـ 

  Edit Typeبعد كدا هدخل علي الـ 

 للتعديل في أبعاد وتخانات الرامب. 

  ×Thickness .تخانة الرامب : 

 ×Material .المادة المستخدمة : 

× أهم جزء بقي في الموضوع كله هو  

 :Dimensionالـ 

1. Maximum Incline 

Length اللي بضيف من  : دا

خلالها طول الرامب اد ايه  

 كمسافة.

2. Ramp Max Slope  دي :

اللي من خلالها بعرفه ان الميل  
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بتاع الرامب دا هيكون كام واللي متعارف عليه في التنفيذ انك لو هتعمل  

 .  1:4أو  1:6رامب سيارات بيكون 

 

 

 

 

 

 

 

تمشي أفقي مسافة متر تحت الأرض يبقي ه  3اذن انه لو عايز تنزل مسافة قدها 

 متر.  18قدرها 

 (Slope= 6:1 ,  Vertical= 3m  , Horizontal= 3*6=18 m ) 
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 لو عايز تظهر الدرابزين بيكون من الآتي كما فعلنا في السلالم: 
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لو عايز تعمل رامب دائري بيكون بنفس الفكرة بس بنستخدم الشكل الدائري 

الخصائص.وبيكون بنفس 
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 الثامنةالمحاضرة 
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 Bill of Quantities –حصر الكميات  

من أفضل وأقوي البرامج الهندسية  Revitفي بداية الأمر معروف أن برنامج الـ 

 Workالمستخدمة في حصر الكميات حيث أي عنصر انشائي يتم رسمه أو نمذجته في الـ  

plane  .نستطيع أن نحصل علي شيتات حصر لها 

 لذلك كان يجب من بداية الأمر عند رسم أي عنصر انشائي الألتزام بالتالي: 

 المادة.                                ×أبعاد القطاع.  × أسم القطاع.                          ×

 وذلك لتسهيل الحصر كل عنصر علي حدا. 

 

 يتم الحصر عن طريق:

View Tab > Create Panel > Schedule 

 

 :Scheduleعناصر مختلفة من  6هناك 

1.  Schedule / Quantities ودي اللي هنستخدمها في شغل الحصر بتاعنا حيث :

 علي حصر كل العناصر الانشائية. تعمل 
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2.  Graphical Column Schedule وتستخدم لعمل حصر للأعمدة عن طريق :

  المناسيب.

 

 

 

 

 

 

3. Material Take off  وتستخدم في عمل حصر كميات في التشطيبات وليس :

 الخرسانات والتسليح وعادة مايستخدمها المهندس المعماري. 

 . امهم في تلك الجزئية نقط يتم استخد 3ما سبق كان أهم 

 

Schedule / Quantities 

 أول ما بفعلها بيظهر لي القايمة دي: 

بيقولي هنا انت عايز تعمل حصر لجزء كهرباء  

 . Filter Listولا مدني ولا ايه بيكون من الـ  

ببدأ أحدد من هنا اي  Structureبعد محدد الـ 

عنصر انشائي أنا عايز احصره بس لو هتحصر 

أي عنصر أنشائي بختار أي حاجه بيكون قبلها  

سواء كانت كمرات أو   Structuralكلمة 

 بلاطات أو أعمدة ....إلخ. 
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 . Viewهناك طريقة أخري عشان أقدر أفتح شيت حصر بدلاً من الدخول من 

 . Schedule / Quantitiesومن ثم  Project Browserويتم ذلك عن طريق من الـ 

  . Structural Columnتعالوا بقي بعد مفتحنا الجزئية دي نبدأ حصر للأعمدة الخرسانية 

بعد ظهور تلك الواجهة يوجد بها  

 الأتي:

1. Fields ومن خلالها بنحدد :

ايه اللي عايز أحصره بالضبط 

سواء حجم الخرسانة أو وزنها  

 Familyأو أسمها أو الـ 

Type  .إلخ... 

2. Filter  بحدد من خلالها انا :

عايز أحصر ايه بالتحديد ومن  

 منسوب كام لمنسوب كام.

3. Sorting/Grouping  :

ومن خلالها بنسق شكل 

 الحصر.

4. Formattingر أعمل تجميع لكل صف أو عمود علي حدا : ومن خلالها بقد 

5. Appearance .شكل شيت الحصر : 
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 .Propertiesما سبق هيظر معاك تاني في الـ 

 دا شيت حصر بدائي للأعمدة بدون التعديل وعمل تنسيق له. 

 .Properties > Othersلو عايز اظبط شكل شيت الحصر بشكل أفضل هرجع ادخل في الـ 

 . Sorting & Groupingقائمة الـ 

والاول تعني  Descendingو الـ  Ascendingفي البداية بيكون عندك حاجتين اسمهم الـ 

الترتيب تنازلياً والاخري 

 تصاعدياً. 

 : Header & Footer× الـ 

استخدامهم للتنسيق  ودول بيتم 

وتحويل النمط المعتاد لكتابة كل  

عنصر لوحده ومع نموذجه 

وأيضاً تكعيب قطاع العمود 

 الخاص به. 

 : Blank Line× الـ 

تترك خط أو خانة فاضية بين  

 كل نموذج والأخر.

 



 

  © Copyrights Engr. Ayman A. El-Bestawy – All Copyrights Reserved   
       For any Inquiries Please Contact (01064662424)             

Autodesk REVIT Structure Diploma                                                                                    Engr.Ayman Ashraf Elbestawy 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Blankبعد تفعيل الـ 

Line : 
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 Grandمرة واحدة بيكون عن طريق   Sumلو عايز تجميع لكل الحجم مرة واحدة أو لو عايز تعمل 

Total  بس لازم تلغي تفعيل الـItemize Every Instance لأن دي تعني فرد كل عنصر لوحده. 
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ومن    Formattingلو عايز بقي تظهر الأرقام اللي مش ظاهرة في الحجم دا بيكون من قائمة الـ 

 . Calculate Totalخلالها هختار 
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أنا لحد دلوقتي عرفت ازاي احصر الاعمدة في المشروع ككل لو عايز بقي احصر الأعمدة عند كل دور 

 . column Splitفي البداية هقص الأعمدة الأول عند كل دور من الـ 

 

وبحددله منسوب الأدوار اللي عايز أحصر   Filterهرجع بقي لشيت الحصر بتاعي وبعدين من قائمة 

 عندها. 
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كما يمك أظهار وأخفاء الصفوف و أعمدة  Excelويمكن العديل في الشيت كما هو في برنامج الـ  

 الحصر وذلك من خلال طريقيتين: 

 . Hideأحدد اسم أو العمود من فوق ومن ثم   .1
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ولو عايز ارجع اي حاجه من اللي كانت موجودة بتكون من خلال   Othersبيكون من قائمة   .2

Unhide . 

 

دلوقتي عايز أعرف نسبة الزلط والرمل والاسمنت والحديد في قطاعات الاعمدة اللي لسه 

 عاملها حصر: 

 في البداية المتر المكعب من الخرسانة المسلحة بيتكون من: 

 ) كمية الزلط (.                                    0.8المتر المكعب ×  •

 ) كمية الرمل (.                                    0.4المتر المكعب ×  •

 كيلو"              ) كمية الأسمنت (.  350شكاير " 7المتر المكعب ×  •

 

 ويتم ذلك في البرنامج من خلال: 

ثم   Volumeفي البداية هحدد الـ 

 . Calculated Valueأختار 
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 بالمثل كمية الزلط.

 :Trickبالنسبة بقي لحجم الاسمنت بيكون فيه 

عشان أنا عايز أطلع عدد   Numberبالـ   Typeهنا بقي هنضحك علي البرنامج حيث هنخلي الـ  

  1نقسمه علي " Volumeالأطنان وليس حجم وكمان لما نيجي نكتب صيغة المعادلة هناخد الحجم "

لـ  3Mحيث الواحد الصحيح هنا هيكون عبارة عن رقم وهمي عشان يحول الحجم بدل الوحدة بـ 

Unitless بلا وحدة. 
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اللي هوا عند تغيير أي  Dynamic Updateمن مميزات الحصر في برنامج الريفيت انه بيشتغل بـ 

 قطاع في المشروع بيتحدث بشكل تلقائي في شيت الحصر.

 

 ( في شيت الحصر.   70*30بالفعل تم تعديل قطاع العمود الجديد ) 
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من مميزات شيتات الحصر أيضاً أنه عند تحديد أي شكل قطاع في الشيت يظهر لك تحديده في الـ  

Plan & 3D View . 

بقدر من خلالها بظهر الشكل بتاعي في اكتر من  Highlight in Modelويمكن أيضاً من خلال  

 عرض. طريقة 
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ولو عايز  Showوبالنسبة لتلك الرسالة تعني ان كنت تريد اظهار قطاعات بأشكال اخرى بضغط 

 .Closeالقطاع دا بضغط 
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 بالنسبة بقي لعزل رقاب الأعمدة والقواعد المنفصلة:

 حصر العزل= ) المساحة الجانبية للقطاع بتاعك ومثلا هوا قطاع العمود (

 = ) محيط قطاع العمود × أرتفاعه (              

 

عشان أعرف أجيب المحيط فلما تيجي تدور   Hوالطول  Bدلوقتي انا محتاج عرض العمود 

 Calculatedعليهم من أول جزء شرحناه في المحاضرة عشان تعرف تضيفهم في الـ 

Value مش هتلاقيهم وعشان تضيفهم معاك هتعمل التالي: 
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 بتاعته.  Familyفي البداية هنحدد قطاع العمود ونفتح الـ  

 .Family Typeهحدد قطاع العمود ثم أختار 
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ودي قطاعات   b , hبيكون متعرف عندي قطاع الـ  

 العمود اللي أنا محتاجها.

 

 

 

 

 

هختار منها   Parametersهاجي من الـ 

Modify . 
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عشان احطه كـ   Createمن هنا هبدأ أقوله أعملي 

Parameter .في شيت الحصر 

 بعد كدا هسمي الملف بتاعي وأحفظه في أي مكان.

 

 

 

 

 

 بعد كدا. Newبعد محفظت الملف هقوله 

 .ويكون نفس الاسم Smallبعد كدا هكتب اسم تاني بس دايماً يكون كله 

  مرة أخري. Newهرجع تاني بعد كدا أقوله 
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 لحد موصل خالص للواجهة دي. OKبعد مخلصت النقطة دي هضغط بقي 

  

 Load into Projectبعد مخلصت هقوله  

 Overwrite the Existingومن ثم هختار الـ  

Version . 

 

 

عشان   Fieldدلوقتي بقي يا هندسة لما تيجي تفتح الجزء بتاع شيت الحصر تاني وتيجي من قائمة الـ 

 موجود.  bهتلاقي الـ    Parameterتضيف 

 . hهنعمل نفس الخطوات تاني بس علي الـ  
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أعمدة بحصر الأعمدة اللي فيها مشكلة  3في حالة بقي لو كان فيه مشكلة في حصر مثلا 

 دي ازاي: 

 < Identity Dataنماذج وبيجي من الـ   3في بداية الأمر بيكون الأستشاري مثلا محدد الـ  

Comment  .وبيسيب تعليق أو ملاحظاته علي الأعمدة دي 

 هظبط اعداداته.   Filterثم بعد ذلك من  Commentحاجة أسمها الـ   Fieldبحدد بقي من الـ  

 

 وبكدا تقدر تحصر الثلاث أعمدة فقط.
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حساب   Cost Estimationالا وهو الـ   5Dفي برنامج الريفيت كمان تقدر تعمل الجزء الخاص بـ  

 ومن ثم اخراجها في شيت الحصر. Costتكلفة المنشأ عن طريق تحديد قيمة للـ  

 

 حيث بضيف قيمة تكلفة العمود الواحد علي سبيل المثال. 
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ا والسلالم وكل عنصر يتم رسمه في برنامج الـ  ما سبق نقدر نعمله مع الكمرات والبلاطات والاساس

Revit . 
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 بالنسبة لجزء التنسيق في برنامج الريفيت لشيت الحصر: 

 

Shading .تستخدم لتغيير الألوان الخليفة أو الخلية : 

Border .الحدود الخارجية للخلية : 

Font نوعية الخط المستخدم وبالمثل تستطيع محاذاته أفقي ورأسي من :Align . 
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 : Format Unitsوبالمثل لو عايز تعمل شيت حصر بوحدات مختلفة تماماً عما سبق يتم من 

 

بحيث هقوله أنا هستخدم وحدات مختلفة ثم   Use Project Settingsفي البداية هلغي تفعيل الـ 

 لي أنا عايزها بعد كدا.بعد ذلك هضيف الوحدات ال
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Revit to Excel 

 Excelالتصدير من برنامج الريفيت لبرنامج الـ 

Menu Browser > Export > Reports > Schedule 

بس لازم الأول أكون عامل شيت حصر وواقف فيه عشان تتفعل العلامة الخاصة بـ  

Schedule . 
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  Textوهي خاصة بـ الـ  txtبعد مخلصت هحفظ الملف ولكن يراعى أنه تم حفظ الملف بصيغة الـ 

 . Excelالخاصة ببرنامج الـ   Xlsxوليست كصيغة الـ 

 .Excelبعد تلك الخطوة سنقوم بفتح برنامج الـ 

 



 

  © Copyrights Engr. Ayman A. El-Bestawy – All Copyrights Reserved   
       For any Inquiries Please Contact (01064662424)             

Autodesk REVIT Structure Diploma                                                                                    Engr.Ayman Ashraf Elbestawy 

ثم هدور علي المكان اللي كنت حافظ فيه الملف ومن ثم أدخل أغير صغية البرنامج من   Openهعمل  

 ومن ثم أستورد الملف. All Filesالي  Xlsxالـ 

 

 ثم بعد ذلك نستوردة ونعدل في الملف كما نشاء. 
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 التاسعةالمحاضرة 
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Loads & R.F.T 

  Revitفي بداية المحاضرة سيتم شرح جزئية الأحمال وكيفية وضع الأحمال في برنامج الـ 

 .Straining Actionومن ثم إخراج الـ 

 أولاً: سيتم العمل علي مشروع بسيط ومن ثم وضع الأحمال عليه.

 

 

 

 

 

 

 

 

في بداية الأمر وقبل وضع الأحمال لابد وان يكون المشروع كاملاً المادة المستخدمة فيه من الخرسانة 

 . Cast in Placeأو  Cast in Situسواء كانت 

 

 

 

 

 

 

 

 

 

 



 

  © Copyrights Engr. Ayman A. El-Bestawy – All Copyrights Reserved   
       For any Inquiries Please Contact (01064662424)             

Autodesk REVIT Structure Diploma                                                                                    Engr.Ayman Ashraf Elbestawy 

 لوضع الأحمال وحل المنشأ بعد رسمه نتبع الأتي: 

 . Wire Frameتحويل مجال الرؤية للـ   .1

 . Load Patternيتم ضبط الـ   .2

 . Load Combinationيتم ضبط الـ   .3

ثم بعد ذلك وضع الأحمال علي البلاطات والكمرات وتحديد  .4

وأيضاً تحديد الـ   Propertiesمقدار الحمل من قائمة الـ 

Load Pattern   الخاص بها ويراعى عند وضع الحمل

 . Hostedسواء للبلاطة أو للكمرة يكون من خلال الـ 

 

 يتم وضع الأحمال من: 

Analyze Tab > Analytical Model 

 يوجد الأتي: Panelمن خلال هذا الـ 

 ×Boundary Conditions ( ومن خلالها يتم وضع الركائز سواء كانت :Roller – 

Hinged " Pinned " – Fixed   )  . 

 .Library  –ولو مش ظاهر معاك أشكال الركائز تقدر تضيفهم من المكتبة 

ثم بعد ذلك هضيف الركايز  Boundary Conditionثم بعد ذلك هفتح المكتبة وهختار منها الـ  

 اللي عايزها. 
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 ×Loads ومن خلالها يتم وضع الأحمال سواء حمل على كمرة أو بلاطة أو قطاع عمود ويراعى :

 الخاصة بالحمل.  Snapعشان الـ  Hostedطبعاً أن يكون 

 ×Load Case ودي بالنسبة ليا هي الـ :Load Pattern   ودي اللي من خلالها بعرف البرنامج

 .Dead Load , Live Load , Flooring Cover , Seismic Loads …etcان عندي 

 ×Load Combination  ودي اللي منها بعمل الحالة التجميعية للـ :Working , Ultimate . 
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 الركايز عليه شكل المشروع بعد وضع أحمال وتوظيف 
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بعد وضع كلا من الأحمال والركائز في البرنامج يتم حل المنشأ ولحل المنشأ يجب أولا  

 .Extensionتحميل ما يسمي بالـ  

 

 

 

 

 

 

 

 

عمل تحليل إنشائي للبلاطات بينما الـ   Static Analysis of Slabيتم من خلال الـ 

Static Analysis of Beam  .تستخدم لعمل تحليل انشائي للكمرات 

 بس قبل حل البلاطة يجب أولا تحديد البلاطة الخرسانية حتي لا تظهر تلك الرسالة. 
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بعد تحديد البلاطة هيظهرلك رسالة بيقول فيها انت  

  عايز تحسب الوزن الذاتي للمنشأ ولا لا.

 

 

 

 حيث هحدد الكمرة الأول ثم أكمل.  Beams – بالمثل ماسبق مع الكمرات 
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 . Extensionبالنسبة لباقي الحاجات اللي موجودة في الـ 

ودي من خلالها بقدر أضيف الكود اللي محتاجه  Preferencesبيكون موجود حاجة اسمها الـ 

 مصري. –بريطاني   –وأعدل فيه سواء كان كود أمريكي 

 

 دا هنستخدمة بس في جزء التسليح.  Reinforcementبالنسبة بقي لجزء الـ 
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 Connectionودي من خلالها بقدر أعمل الـ   Steel Connectionبالنسبة بقي لجزء الـ 

Between Rafter & Column.    

 

 . Extensionدلوقتي أنا رسمت كمرة وعمود هحدد الأتنين مع بعض وبعد كدا هشتغل بالـ 
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F. T" Reinforcement "R. 

 في البداية سيتم التطبيق علي نموذج مبسط لقاعدة مسلحة ورقبة عمود.

 التسليح في برنامج الريفيت يتم من خلال طريقتين: حيث أن  

1. Structure Tab > Reinforcement Panel  .وهي الطريقة الأصعب 

 . Extensionsاستخدام الـ   .2

 :Reinforcement Panel :أولاً 

 ×Rebar.ومن خلالها يتم تسليح الكمرات والأعمدة والقواعد : 

 ×Area البلاطات واللبشة.: ومن خلالها يتم تسليح 

 ×Path .ومن خلالها يتم رسم الحديد الإضافي في البلاطات : 

 ×Fabric Area & Fabric Sheets.يتم استخدامهم في المشاريع الخارجية : 

 ×Cover 2سم والأعمدة  2: ومن خلالها بظبط خلوص العنصر الإنشائي حيث البلاطات -

 سم.  7-5سم وبالمثل الكمرات والأساسات  3

 

هنبدأ بقي بالـ  

Cover: 

اللي هيظهر  

معاك هوا الـ  

Option 

Bar . 
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 فيه خيارين لرسم الخلوص:  Option Barبيكون في الـ 

Pick Element:  

 حيث من خلالها يتم تحديد القطاع الانشائي ومن ثم يتم عمل الخلوص له بشكل كامل. 

Pick Faces : 

ويأخذ هذا الوجه خصائص وأبعاد الخلوص حيث من خلالها يتم تحديد وجه واحد فقط  

 المُعرف. 

 

 . Cover settingsخاص في البرنامج من خلال الـ  Coverيتم تعديل وأضافة 

كل اللي عليك بعد ضبط اعدادات الخلوص انك تلمس شكل القطاع ومن ثم تيجي من الـ 

Option Bar .ثم بعد ذلك نختار الخلوص اللي أنت عايزه 
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القواعد بس لو عايز اخلي الوجه الاسفل مع القاعدة المسلحة يكون ذو وبالمثل دي في  

 . Pick Faceسم يتم ذلك من خلال الـ  7خلوص 

 

  Sectionبعد كدا ندخل بقي علي تسليح القاعدة والعمود بس في البداية لازم ناخد فيهم 

 .الأول عشان أعرف اسلحهم
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 اللي عايز تعمله تسليح بيظهر الأتي: ثم الشكل بتاعك  Rebarأول ما بتحدد الـ 

ودا من خلالها بيكون متاح كل الأسياخ الطولية والعرضية    Shape Browser   Rebarبيكون الـ  

 وجميع القطاعات. 

 ملحوظة: 

 . قفل الكانة بيكون في اتجاه الضغط وليس الشد

 . Option Barاختفي معاك وعايز تظهره  دا بيكون من الـ   Rebar Shape Browser لو الـ 

 

ملي بيكون أسياخ طولية   16أسياخ قطر  6بيكون معاك بقي تسليح قطاع العمود علي سبيل المثال 

 وهناك كانات عرضية. 

  Ribbonومن الـ   Rebar Shape Browser  الـيتم وضع حديد التسليح بشكل بسيط جدا من 

أو عمودي عليها   Parallelيتم تعديل وضبط وضعية السيخ سواء كان موازي للواجهة 

Perpendicular . 
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 . Propertiesولتحديد القطر المستخدم بيكون من الـ 

 . Edit Typeلو عايز تضيف قطر أخر يتم ذلك عن طريق الـ  
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 من هنا بقي بقدر أعدل في خصائص الأقطار حيث: 

 ×Materialا زي ما هيا عشان أنا شغال  : بسيبه

 بالكود الأمريكي. 

 ×Bar Diameter.وهو قطر السيخ المستخدم : 

 ×Standard Bend Diameter : 

وهو قطرالانحناء في السيخ زي ما كنا بنعمل في 

برنامج الكاد 

   .Filletبأمر 

 

 

 

 

×Stirrup / Tie Bend Diameter .وهو طول قفل الكانة :  

 

 . Phi8وبكدا تم إضافة قطر السيخ المستخدم 
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بينما    parallel to Work Planeنبدأ بقي نضيف الأسياخ الطولية حيث الأسياخ الطولية تكون 

 . perpendicularالكانات تكون  

ملي دا بيكون من خلال تحديد  16أسياخ قطر  3لو عايز بقي أعمل أكتر من سيخ مع بعض يعني مثلا 

ودي بتكون موجودة  Rebar Setق رسم السيخ من البداية ومن ثم التعديل في الـ  السيخ أو عن طري 

 . Propertiesوالـ    Ribbonفي الـ 

مش هتلاقيها ظاهرة لو عايز بقي   3D Viewدلوقتي الأسياخ اترسمت بس لما تيجي تشوفها في الـ 

 تظهر دا بيكون من خلال: 

 < Graphicsومن ثم هدخل في الـ  Structural Rebarهحدد الاسياخ لوحدها بس 

Visibilities / Graphics   3ثم بعد ذلك بدخل علي الـD View   .وبظهر كل اللي فيه 
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 . Perpendicularوبالمثل هعمل الكانات بس هتكون 

 

وتغيرها    Propertiesلو نسيت ومظبطش قطر الكانة بتحددها تاني بكل بساطة وبعدين بتجي من الـ 

 وخلاص.   Phi8لـ 
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لو عايز كمان تخلي قفل الكانة يكون تبادلي دا بيكون من خلال بحدد الكانات ثم بعد ذلك هخلي المسافة  

  مم. 400الكانات بين 

ملي تقريباً ثم بعد  200في منتصف المسافة ع بعد  Copyثم بعد ذلك هاخد نفس الكانات هعمل منها 

 فبتغير ضربهم. Spaceذلك هحددهم وأضغط مسطرة 
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 تكثيف حديد الكانات في قطاع العمود:

 متر.  1وبعدين بنعمل خط علي بعد  Annotate > Detail Lineبنجيي بقي من قائمة 

 

 .ليا عشان الأسياخ متتخطاهوش Guide Lineبستخدمها عشان أعمل  

لتحت من الأسياخ دي  Copyهسحب بعد كدا الأسياخ اللي تحت الخط دا اخليهم فوقه وبعدين أعمل 

 ملي. 100واكثفهم علي 

 

 

 

 

 

 

 



 

  © Copyrights Engr. Ayman A. El-Bestawy – All Copyrights Reserved   
       For any Inquiries Please Contact (01064662424)             

Autodesk REVIT Structure Diploma                                                                                    Engr.Ayman Ashraf Elbestawy 

لو عايز كمان أطلع أشاير العمود أو رقبة العمود مسافة دا بيكون من خلال 

 طريقتين: 

  عن طريق سحب الأسهم لأعلى. .1

  .Propertiesقائمة الـ  .2

 

 

 

 

 

 

 

 في حالة بقي عايز أعمل سيخ التداخل بين العمود والقاعدة المسلحة بيكون كالتالي: 

 نعمل دا كمان في الاتجاة الأخر بالمثل.

 وبكدا يبقى خلصنا جزء رقبة العمود بكل تفاصيلها.
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 الأعمدة نكمل في جزء الأساسات. دلوقتي بعد مخلصنا جزء 

 "القواعد المنفصلة"

 زي معملنا قبل كدا مع الأعمدة.

 . Rebar Setثم بعد ذلك هظبط الـ  

 وبالمثل هعمل التسليح في الاتجاهين. 
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 ×View Unobscured : 

ودي من خلالها بظهر الحديد بداخل الخرسانة 

والخرسانة بس اللي بتكون ظاهرة والحديد مش 

 ظاهر.
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 ×View as Solid :  

بيظهر بيه الخرسانة وحديد التسليح  

 معاً. 

 

 

 

 

 

 Slabs –البلاطات  

أو   Solid Slabبالنسبة لتسليح البلاطات هوا نفس طريقة التسليح في البلاطات المصمتة 

 . Flat Slabالبلاطات المسطحة  

 ومن ثم:  Planحيث يتم التسليح عن طريق الوقوف في الـ 

Structure Tab > Reinforcement Panel > Area Panel 

ثم بعد ذلك أحدد حدود البلاطة الخارجية ومن ثم أرسم شكل التسليح   Areaهحدد الأول 

كان  سواء  
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 علي شكل مستطيل أم علي شكل دائري ..إلخ. 

 

 

 

 

 

 

 

 .Major Directionبعد ذلك هحدد الأتجاة الطويل والأتجاة القصير في التسليح عن طريق الـ 

وبالنسبة لتحديد عدد الاسياخ وهل التسليح علي شبكتين علوية و سفلية أم لا و قطر السيخ المستخدم 

 . Propertiesيتم ذلك من خلال الـ 
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اللي مكتوب في المستطيل الأبيض دا يعني استخدمت  

 5ملي يعني   200ملي كل  16أسياخ تسليح قطر 

 أسياخ في المتر الواحد.

 

وجودة لو مش عارف معاناه وبالنسبة للرموز الم

  بتجيبها من:
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 بالنسبة لحصر البلاطات في حالة وجود تسليح

 . Revitمدعم في برنامج الـ  Dynamic Updateبما ان الـ 

في بداية الأمر هنرجع  

لشيت الحصر ثم بعد ذلك 

نضيف منه   Fieldنفتح الـ 

Estimate 

Reinforcement 

Volume   ثم بعد ذلك

 .3Mنحول والوحدات للـ 

 

هظبط فيها   Calculate Valueبعد كدا هاجي من الـ  

Formula  جديدة من خلالها هقدر أطلع وزن الحديد

الا  7.85المستخدم عن طريق ضرب حجم الحديد × 

وهي الكثافة النوعية  

 للحديد.
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 الحديد ÷ حجم الخراسانة (. ) وزن لو عايز بقي تجيب نسبة الحديد في الخرسانة= 

 

 نرجع تاني بقي لموضوع التسليح بتاعتنا. 

 لو عايز تحذف التسليح اللي أنت راسمه بيكون من تحديد الحدود الخارجية وبكدا يبقي اتسمح. 
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في  Sectionبالنسبة لتسليح الكمرات والأعمدة بيكون بالظبط زي معملنا أول المحاضرة حيث بعمل 

 . Rebarثم بعد ذلك أسلحة من خلال الـ    Sectionالكمرة ثم بعد ذلك أظهر الـ 

 

 

 

 

 

 

 

 

بس الطريقة السابقة تحتاج المزيد من الوقت ولكن هناك طريقة أسهل ودي اللي هنستخدمها في 

 .Extensionsالمشروع الا وهي بإستخدام الـ 

 

 يتم من هنا تسليح البلاطات والكمرات بشكل أفضل و أسرع.

 



 

  © Copyrights Engr. Ayman A. El-Bestawy – All Copyrights Reserved   
       For any Inquiries Please Contact (01064662424)             

Autodesk REVIT Structure Diploma                                                                                    Engr.Ayman Ashraf Elbestawy 

   

 وبكدا يبقي عملت تسليح كامل للكمرة الخرسانية.
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 قطاعات الأعمدة:وبالمثل مع 

 

 بالنسبة بقي لتسليح الحوائط الخرسانية. 
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بتكون بنفس النظام كما في الأعمدة والكمرات والبلاطات حيث أن تسليح الحائط هوا اللي بيمشي علي 

 . Shear Walls & Coresالـ 

  

 : Dynamic Model Updates بالنسبة للـ

حيث الطول أو العرض بشكل أوتوماتيك التسليح هيتغير ودي من خلالها لو زودت في أبعاد القطاع من  

 اما بالزيادة أو بالنقصان.
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 العاشرة المحاضرة 
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Sheets & Printing 

وأيضاً ضبط   2D,3D Viewخلال تلك المحاضرة هنتعلم ازاي بنعمل اخراج للوحات في الـ 

 الخاصة باللوحات. Pen Assignmentوتعديل الـ 

 – 0Aــ من المعروف ان مقاسات الورق الموجودة في السوق اللي بنطبع عليها بتكون )  

4A – 3A – 2A – 1A .) 

يجب أولاً قبل رسم أي لوحة تحديد مقياس الرسم المستخدم فيها ويتم ذلكعلي حسب ــ 

 Scale ( 1:50 – 1:100 – 1:200 ...etc.)اللوحة المستخدمة أما أستخدم 

 .2هنقسم علي  1:200والعكس مع  2يعني اننا هنضرب القيم ×  Scale 1:50ــ حيث 

 :Pen Assignmentــ ايه هيا بقي الـ 

ودي بنستخدمها عشان نوضح اللوحة حيث بتدي لكل قطاع في اللوحة شكل مختلف يعني الأعمدة  

 ...إلخ. بتكون ذات تخانات محددة وبالمثل الكمرات والبلاطات والأساسات 

 دا بيكون من خلال:  Pen Assignmentــ عشان أظبط بقي موضوع الطباعة بالـ 

Manage Tab > Setting Panel > Additional Settings > Line Weights 
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من خلال تلك القائمة بقدر أحدد في تخانة 

الخطوط وكل عنصر انشائي يتم رسمه في 

 اللوحة. 

 

 

 

 

 

 

 لو عايز بقي اعرف أرقام لكل عنصر انشائي مرسوم وبالتالي تحديد أبعاده يتم ذلك من خلال: 
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 بيكون فيها الآتي: Object Styleمن خلال الـ  

× Category  :.ودي بيكون فيها العناصر الأنشائية المستخدمة والمرسومة بالفعل في القطاع 

 ×Line Weight ودا بينقسم لنوعين لـ :Projection   وCut  ودول بيكونوا اسقاط اللوحة أولا

 بيكون له تخانة مقدارها كام. والثانية لو واخد قطاع فالعنصر الأنشائي 

 ×Color.دي من خلالها بقدر أعدل وأغير من خلالها لون الخط والعنصر الأنشائي : 

 ×Line Pattern:  من خلالها يتم تعديل نموذج الخط سواء كانSolid or Dashed Line …etc. . 

 

 الأنشائية. دا بالمثل هنعمله مع باقي المشروع ومع جميع العناصر 
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Sheets 

 يتم عمل اللوحات من البرنامج من خلال:

View Tab > Sheet Composition > Sheet 

بعدها بيقولي أنت عايز تطبع   Sheetsأول ما بحدد الـ 

علي لوحة مقاسها كام ولو مش لاقي مقاس اللوحة اللي  

  أنت عايز تطبع عليه بتستورده من المكتبة.
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 مضيف اللوحات كلها هتختار بعد كدا اللوحة اللي انت عايز تشتغل عليها. بعد 

دا بقي بيكون عن طريق حاجتين الأولى عن طريق الضغط مرتين علي   Frameلو عايز تعدل في الـ  

 .Edit Familyالفريم أو تحديده ثم الضغط علي 

بعد كدا هبدأ أنضف المشروع بتاعي ككل وأي حاجة عايز أمسحه أو عايز أضيفها ولو عايز أضيف 

 . Insert > Imageصورة مثلا لوجو الشركة بتاعتي بيكون من 
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 اللي فوق.  Ribbonايز تضيف أي حاجه شكل مثلا أو كتابة دا بيكون من الـ في حالة بقي ع

 

دلوقتي بقي عايز أضيف المشروع في اللوحات ودا ببساطة بيكون عن طريق سحب اللوحة ووضعها  

 Project Browser > Sheets > Name of Sheetفي اللوحة بتاعتك اللي موجودة في الـ 
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  Planعشان بقي أضيف أي لوحة أو أي قطاع في المشروع بتاعي دا بيتم من خلال الوقوف في الـ  

 نفسه ومن ثم سحب القطاع أو البلان الانشائي ووضعه في اللوحة. 

دا بيكون عن طريق تحديد اللوحة المسحوبة ومن ثم  Scaleلو عايز بقي تكبر أو تصغر في الـ 

 اص بها. التعديل في مقياس الرسم الخ
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 . Right Click > Deactivate Viewلو عايز ترجع تاني بقي للوحة بيكون من خلال  

 . Show Crop Regionلو عايز تقص حاجة من اللوحة المسحوبة بيكون من خلال الـ 

 

 وبكدا هبقي ظبطت الوحدات وأبعاد الرسمة واللوحة الخارجية نفسها. 
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 . Show Titleبالنسبة للكلمة اللي مكتوب فيها منسوب المسلحة دي بنسميها الـ 

وبالمثل نعمل كدا ف باقي اللوحات حيث ممكن تضع أكثر من لوحة بأكثر من مقياس رسم مختلف في 

 لوحة واحدة فقط.

 يمكن أيضاً إضافة شيتات حصر داخل هذا الفريم الواحد.
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 يقتين للطباعة: بعد مجهزنا اللوحات هناك طر

 . Ctrl > Pعن طريق  .1

2. Menu Browser > Print . 

 . AutoCADثم بعد ذلك هعمل كما كنت بعمل في برنامج الـ  
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 ×Name  من خلالها بحدد أسم الطابعة أو :

 . PDFالبرنامج اللي هحول الملف ليه كـ 

هعمل   Properties× بعد كدا هدخل من الـ  

التعديلات اللي  

موضحة في 

الصورة من حيث  

لون الطباعة  

Black & 

White . 

 

 

هعدل فيه مقاس اللوحة مرة أخري   Layout× بعد كدا هدخل من الـ  

بحيث يكون مناسب بشكل تام مع مقاس اللوحة اللي كنت مجهزها في  

 .2Aيبقي هخليها   2Aالبرنامج يعني لو كنت برسم علي لوحة 

 

 Desktopهحدد مكان الطباعة أو حفظ الملف مثلا علي الـ   × بعد كدا

 . PDFوبكدا يبقي تحول لملف  

 

 

 

 

 

 

قبل   Previewدا شكل الـ 

 الطباعة. 
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Export for AutoCAD 

"  "Etabsكان من اللازم لكي تحلل مشروع كامل علي برنامج التحليل الإنشائي   2009حتي عام 

وتلك كانت مشكلة لمن لا يستطيع تحويل   3D Modelingكان من اللازم عمل المشروع على هيئة 

حيث من خلال التصدير   Revitوقد تم حل تلك المشكلة في برنامج الـ  3Dلـ  2Dالمشروع الـ 

 . 3Dلـ  2Dيتحول المشروع من الـ  AutoCADلبرنامج الـ 
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 الحادية عشر المحاضرة 
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Robot Analysis from Revit 
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 في بداية الامر هنعمل مشروع كامل علي برنامج الريفيت كما ذكرنا قبل ذلك.

 .Analytical Modelولازم نكون مفعلين الـ  
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أهم نقطة في رسم المشروع ان المادة المستخدمة تكون واحدة يعني كله خرسانة عشان تعرف تعمل  

Analysis on Robot . 

 كما تعودنا.  Analyzeبعد كدا نبدأ في وضع الأحمال علي المشروع من قائمة 

 ونعرف حالات التحميل والركائز وكل شئ. 

 

البلاطات  هنا تم وضع الأحمال علي 

والكمرات ووضع وتوقيع الركائز في 

 المشروع. 
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نقوم بتصدير المنشأ لبرنامج الروبوت من   Revitبعد الانتهاء من العمل علي المشروع في برنامج الـ 

 خلال: 

Analyze > Structural Analysis > Robot Structural Analysis Link 

 

قد تحدث مشكلة عدم التصدير   Robotعند التصدير لبرنامج الـ 

حيث يكون اسم المشكلة   Windowsويكون السبب في نسخة الـ  

Unknown Run Time Error . 

 :التالي Pathولحل تلك المشكلة نتبع الـ 

 هنحدد ملف أولا وهوا  .1

My Computer > Local Disk C > Program Files > Common Files > 

Autodesk Shared > Extension 2016 > Modules > Rsa > DRevit2Robot 
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 التالي:  Pathبعد ذلك نقوم بنسخ الملف ووضعه في الـ  .2

Program Files > Autodesk > Autodesk Robot Structural Analysis > 

System > Exe > Paste 

 دلوقتي بعد التصدير مرة أخري: 

بعد كدا هسيب البرنامج يعمل  

Export    وأول ميخلص هيفتح

 . Robotالمشروع علي برنامج الـ 

  

 

 

 

 

يظهر رسالة بأنه تم تصدير المشروع بنجاح  Robotبعد تصدير المشروع بأحماله علي برنامج الـ  

 ويتم فتح البرنامج بشكل تلقائي. 
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وبالمثل  Revitكما تم تعريفها من قبل علي برنامج الـ  Hingedكل حاجة هنا مظبوطة الركائز 

 الكمرات والأعمدة والبلاطات. 

 لو عايز تشوف تخانة البلاطة كمان بيكون من 

View > Display > Panels/FE > Panel Thickness 
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ودا بيتم من خلال الـ    Straining Actionدلوقتي بقي أنا عايز أعمل تحليل انشائي وأظهر الـ 

Calculation   اللي هوا موجود من قائمةAnalyze . 
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بتلك الخطوة يبقي كدا انا خلاص عملت  

 تحليل انشائي للمنشا. 

 

 

 

 

 

 

 

 

 

 . Revitالبرنامج لما بيحل المنشأ بيحل علي الحالات التجميعية اللي كنت مجهزها من خلال برنامج الـ  
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 في البرنامج.  Calculationبعد معملت الـ    Meshesدا شكل الـ 

 . Meshesولو عايز اخفي الـ 

 . Straining Actionدلوقتي بقي عشان تظهر الـ  
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 ×Bars  في البرنامج تعني الكمرات والأعمدة بينما الـMaps   دي بستخدمها لإظهار الـ

Straining Action  .علي البلاطات 

 فبيظهر الأتي: Diagrams for Barsدلوقتي لما بحدد ال 

  Fzأمام الـ  Check Markدلوقتي عشان اظهر رد فعل كل عمود بيكون من خلال وضع علامة الـ  

 . Descriptionوالـ 

 

 

 

 

 

 

 

 

 

 



 

  © Copyrights Engr. Ayman A. El-Bestawy – All Copyrights Reserved   
       For any Inquiries Please Contact (01064662424)             

Autodesk REVIT Structure Diploma                                                                                    Engr.Ayman Ashraf Elbestawy 

 . Results > Reactionsلو عايز بقي اظهر جدول كامل فيه رد فعل الأعمدة بيكون من خلال  

 . Workingأو   Ultimateوبالفعل هناك التعديل والتغيير في حالات التحميل المختلفة سواء كانت  
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 .علي الكمرات Straining Actionلو عايز اظهر الـ 

 .Check Marksبتكون من نفس اللي جبنامنها الأعمدة بالظبط بس هنغير ونعدل في وضع الـ 

 .Parametersوممكن أغير من شكل العزوم علي الكمرات من خلال الـ 

 

 تبدأ تغير في الشكل اللي يناسبك ويكون مناسب لرؤية العين. 
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لكمرة بقطاع العمود الخاص بها فقط  Isolationانك تعمل  Robotهناك السماحية في برنامج الـ 

 .Straining Actionومن ثم تظهر عليها الـ  

 Edit in Viewالخاص بتلك الكمرة الخرسانية والعمود ومن ثم  Gridيتم ذلك عن طريق تحديد الـ 

. 
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 علي الكمرة والأعمدة فقط  Deflectionبكدا انت أظهرت الـ 

 Moment, Shear ,Normalزي الـ  Straining Actionوبالمثل تقدر تظهر باقي الـ 

Forces . 
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 . Results > Mapsبالنسبة بقي لإظهار العزوم علي البلاطات بيكون من الـ  

 .X-Directionما سبق كان العزوم في اتجاه الـ 

 

 .XYولإظهار الاتنين مع بعض بيكون من خلال الـ  Y-Directionما سبق كان العزوم في اتجاه الـ 
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انك تقدر تظهر أقصى قيمة للعزوم علي البلاطة وذلك بيكون من خلال   Robotمن مميزات برنامج الـ  

 . Value > Extreme Point on Panelالـ 

 Max +veالقيم الموضحة هي أقصى قيمة موجبة و أقصى قيمة سالبة علي البلاطة الخرسانية 

Moment & Max -ve Moment . 
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 Robotالتكرار في برنامج الـ 

 نقوم بتحديد الجزء المراد تكراره.  .1

 .Edit > Edit > Move/Copyثم من قائمة   .2

مرات تكرار ثم بعد  10متر و 3مسافه قدرها  Zهقوله كرر المشروع في اتجاه الـ   .3

 . Executeذلك نضغط علي 

والرسالة اللي ظهرت دي البرنامج بيعرفك بس انك كنت عملت تحليل انشائي للمشروع 

 .ولما نكرر بعد كدا نبقي نحل تاني مش مشكلة Okوالتكرار دا هيمسحه فقوله 
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 نرجع نحل المنشأ مرة أخري. ومن ثم 

 وبالمثل في باقي الاتجاهات ومع الكمرات والأعمدة.
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 Robotتسليح المنشأ علي برنامج الـ  

في بداية الأمر يجب تحليل المنشأ أولاً ومن ثم تحديد العنصر الانشائي وليكن كمرة  

 . Design Tab > Provided Reinforcement > of RC Elementخرسانية ثم 

ومن ثم بتحدد   Manual Combinationي أول واجهة بتظهر معاك بتختار منها الـ د

حالات التحميل المختلفة اللي هتطلع التسليح بناءً علي القيم الخارجة منها زي الـ  

Ultimate & Working . 

 

 بعد كدا بيظهرلك واجهة فيها كل خصائص العنصر الأنشائي اللي انت محددة.
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بعد كدا بضغط علي حاجه اسمها الـ  

Calculation Option . 

 

من هنا ببدأ اعدل في الكود المستخدم  

في التسليح سواء كان كود أمريكي أو  

 بريطاني أو كود هندي ...إلخ 

 

ومنها أيضا بنشوف أقطار التسليح وكل  

 شئ له علاقه بالكمرة ونمذجتها. 
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بالنمذجة نقوم بعد ذلك بحفظ  بعد معدلت القيم الخاص 

 الملف. 

 

 

بعد مخلصنا أول جزء في التسليح من حيث تعريف القطاعات نقوم بعد ذلك بـ  

Reinforcement Pattern. 

 

 

 

 

 

 

 بعد تلك التعديلات هحفظ الملف. 
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 لإظهار التسليح بيكون من هنا.
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  .Beam Noteولإخراج نوته حسابية بيتم من خلال الـ 

 

 وبذلك تم بحمد الله وفضله الأنتهاء من جزء برنامج 

Autodesk Robot Structural Analysis 
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loutlCa 
في البرنامج بس يختلف انك بدل متعمل خط قطع أنت    Sectionدا حاجة بالظبط زي الـ 

بتعمل مستطيل أو مربع أو دائرة أو أي شكل قطع ويتسخدم بكثرة في اللوحات المعمارية 

 . Calloutوعلي سبيل المثال لو عايز أعمل قطاع لحمام أو مطبخ فبستخدم الـ 

 ويتم استخدامه من خلال:

View Tab > Create Panel > Callout 

 

 

 

 

 

 

 

 

 بحدد الجزء الاول المراد أخد قطاع فيه أو من خلاله.

 . Project Browserوبالفعل بيكون موجود معاك في الـ 

 Horizontal Breakويمكن التحكم فيه من خلال تقسيمه الي اكتر من شكل عن طريق 

View   وعن طريق استخدام الـDrags . 
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يمكن من خلالها رسم أي شكل وأي قطاع في المشروع وبالفعل تستطيع وضعه واخراجه  

 . Sheetsفي لوحات المشروع النهائية 
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Certified User Exam 

 . Autodeskدي نماذج هذا الإمتحان من خلال شركة 
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Exam ProfessionalCertified  
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